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1 Introduction

Thanks for purchasing the ECU+ fuel and timing computer. The ECU+ is an inexpensive, full-
featured piggyback computer that modifies the MAS airflow and the cam and crank angle
sensor signals on your 1990-1999 4G63-equipped turbo Eclipse, Talon, Laser or Galant VR-
4, or 2003-2005 Lancer Evolution, giving you complete control over fuel delivery and timing of
your vehicle. The ECU+ is typically used on high-performance vehicles with larger turbos,
upgraded exhausts and higher-flow injectors to fine-tune your vehicle's performance.

The ECU+ can modify the fuel and timing of your engine at some 129 "points," depending on
the engine's air flow, RPM and throttle position. In addition, the ECU+ supports full
datalogging of most engine sensors at 25 samples per second as well as complete OBD-II
functionality. Datalogged information can be viewed and analyzed with the included Palm OS
or Windows software.

2 Warning

The ECU+ system is an sophisticated device intended for off-road use, and is not in any way
certified for use on public streets. The ECU+ provides you with the ability to adjust the
air/fuel and timing mixture of the engine in your car. If used improperly, the ECU+ can
destroy your engine. Neither the dealer nor the manufacturer of the ECU+ may be held
responsible for any damage to your vehicle as a result of the installation, use or misuse of
this product. Additionally, you should never adjust your engine's settings or attempt to “run”
either the ECU+ Win or ECU+ Palm software while the vehicle is in motion.

3 System Requirements

The ECU+ supports the following vehicles:

e 1990-1991 Mitsubishi Galant VR-4

e 1990-1994 Plymouth Laser, Mitsubishi Eclipse or Eagle Talon, AWD or FWD, turbo only
e 1995-1999 Mitsubishi Eclipse or Eagle Talon, AWD or FWD, turbo only

e 2003-2005 Mitsubishi Lancer Evolution VIl

The ECU+ head unit connects via a serial port to a Palm organizer and/or a laptop PC for
data display, logging and analysis.

The ECU+ Palm software, which runs on the Palm Organizer, requires Palm OS 3.5.1 or
later. The Palm organizer itself must have a serial connection (“HotSync cable”) to connect to
the head unit.

The ECU+ Win software requires a Intel, AMD or compatible PC running Windows 98, 98SE,
ME, 2000, or XP. A Pentium 11/366 Mhz or faster CPU is recommended. If the PC is a
laptop, it can be used directly with the ECU+ head unit via a serial connection (be that a true
serial port, or a pseudo-serial port, like a USB-to-serial adapter).

If you have a laptop, you don't necessarily need the Palm organizer. If not, you'll need a
separate PC to run the ECU+ Win analysis software.



4 Packing List

When you purchased the ECU+, you should have received the following items:

e ECU+ head unit — this is the “silver and black box.” When shipped in the plug-n-play (PnP)
version, the head unit is pre-wired into a adapter harness.

e A software CD-ROM containing the ECU+ Windows and Palm software, as well as this
manual and other documentation.

e Two wiring harnesses for connection to the car — one for high-current 1/0 and one for low-
current I/O. For the plug-n-play (PnP) version of the ECU+, these will be pre-wired into a
PnP harness.

e Wire ties.

e A 9-pin straight-through serial cable. Male to female. This is used to interface between
the ECU+ head unit and the laptop

e A null modem adapter, female to female. This adapts the Palm organizer to the serial
cable.

5 Head Unit Hardware Installation

The ECU+ “head unit” is the black and silver box box of the ECU+ system. This device
connects into your car's wiring harness and intercepts various engine sensor signals. The
head unit modifies theses signals based on your inputs, and passes them on to the stock
ECU. This section will explain how to install the ECU+ head unit in your car.

5.1 Tools Required

The ECU+ head unit can be installed by anyone with some basic electrical experience. If you
can hook up a new car stereo, the ECU+ head unit installation will be a breeze. To complete
the installation, you'll need the following tools:

e A set of common screwdrivers and a socket set (for removing the stock ECU).
Wire cutters and a small knife.

Electrical tape.

A pencil-type soldering iron and solder.

A digital multimeter for measuring voltages.

Lots of patience.

5.2 Wiring Basics

To install the non-PnP ECU+, you'll be splicing into the stock wiring harness that connects the
engine sensors to the stock ECU. You'll make one of two types of connections: tapping or
splicing into the stock wiring harness.

5.2.1 Tapping Wires

For most of the signals that the ECU+ head unit needs to see, you'll be strictly tapping into
the stock wiring harness. That is, you won't be cutting the wires at all, but just stripping back
enough insulation so that you can “tap” the wire. Here's what you'll do:
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1. Strip about an inch of insulation from the stock ECU wire.
2. Strip an inch and a half of insulation from the end of the corresponding ECU+ wire.

3. Twist the bare ECU+ wire around the bare stock wire, then solder the two together to make
a solid connection.

4. Wrap this exposed connection with electrical tape.

5.2.2 Splicing Wires

A few of the ECU+ head unit connections require that you actually splice into the stock wiring
harness. This involves cutting a wire in the stock harness and connecting a ECU+ wire to
either end. To splice an end, follow these steps:

1. Cut the stock ECU wire with wire cutters.

A

Strip about an inch of insulation from the stock ECU wire.

w

Strip an inch of insulation from the end of the corresponding ECU+ wire.

s

Twist the two wires together and solder the connection. The two wires will be an inverted
'V' shape.

5. Bend the ECU+ wire backwards and wrap the exposed connection with electrical tape.

5.2.3 Wiring Tips

- The stock wiring harness generally only exposes a few inches of wire from the stock ECU.
Try to make your connections about half-way between the stock ECU connector and where
it disappears under the dash.

- Make sure your hands are clean before wrapping the connection — even the slightest bit of
oil will foul the adhesive on the electrical tape.

- Check and double-check that you're connecting the right wires before soldering. It's much
easier to re-do a connection before soldering than after.

- A good online resource, including photos, for how to make these connections is at
http://www.mmxpress.com/technical/connections.htm

5.3 Locating and Removing the Stock ECU

The procedure for removing the stock ECU depends on the type of car you're installing the
ECU+ in.

For the Talon, Eclipse and Laser vehicles (all years), the stock ECU is mounted vertically and
is located behind the radio in the center console. Remove both the driver and passenger kick
panels, and you'll find the ECU bolted in with three bolts. Remove the bolts and the stock
ECU will slide out. On the 1990-1994 cars, the stock ECU slides out on the passenger side.
On the 1995-1999 cars, it slides out on the driver's side.

For the Galant VR-4, the stock ECU is bolted underneath the dash on the far right side.
Remove the two bolts holding it in place, and it'll drop out.

For the Evolution VIII, the stock ECU is behind the glove box. Remove the glove box (there's
a tab on the left side that'll free the glove box and allow it to drop out) and unbolt the two bolts
holding the stock ECU in place. The stock ECU will drop straight down into the passenger
side floor.
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5.4 Making the Connections

With the stock ECU removed from your vehicle, it's time to do the hookup to the ECU+ wiring
harnesses. All of the cars that the ECU+ supports have similar wiring, but the wire locations
on the stock ECU are different.

5.4.1 1990-1994 Galant VR-4, Laser Talon and Eclipse

On the 1990-1994 Talon, Eclipse, Laser and Galant VR-4, the stock ECU contains three
connectors, numbered as shown in lllustration 1. This view shows the stock ECU as you'll
view it, facing the connectors in the end of the metal enclosure.

Fromt O2 5 ensor

Adr Temperature 3 ensor

+12% Power Injector 1 Knock Bensor
Grownd Ignition 1/4 MAS

k4 m h i L J v Ll"

bt [t [ [ 1

S[5151213| [SISULIRSILIBS (||| o] rfor ol 0[5 ||
= == |on|on O O O O OO | | e || e | i | e | | 3 O 3
gga o t::-—slwhtﬁﬂ"wlm whwmwmm'c—-imw.h

Y

|

Cam & ensor
Crank Sensor

Codlart Temperatire 3ensor
Throttle Position 3 ensor
Speed Sensor

Hensor Ground
Barometric Pressure Sensor

lllustration 1- The first generation DSM ECU pinout

To hook up the ECU+ head unit, you'll be wiring between the stock ECU and one of the two
ECU+ harnesses. There are two ECU+ harnesses — one for “low current” connections (this is
the main harness, containing 34 pins, terminated at the black connector on the head unit) and
one for “high current” connections (terminates at the white connector on the head unit). The
high current harness also includes the power connections.
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lllustration 2 - The low (left) and high (right) current harnesses.

The low current harness connector contains 34 positions arranged in groups of ten. The
groups are labeled “Group A” through “Group D,” and within a group, wires are color-coded in
the following sequence: brown, black, red, orange, yellow, green, blue, violet, gray, white. In
the above illustration, the Group A wires are on the left, then Group B, Group C and Group D.
The leftmost brown wire in Group A is pin 1. Underneath pin 1 is the unused pin 2. The red
wire beside the brown wire is pin 3, and so on. The table below lists all of the connections on
the low current harness, and where they'll connect to on the stock ECU. Note that some
positions on this connector are unused (like pin 2), and there is no wire in that position.

Wiring ECU+ Function

Group

I§ Brown A Sensor Ground

v (Black) A Not Used

£ Red A Cam Sensor Out (to stock ECU)
Z¥ Orange A MAS In (from sensor)

ol Yellow A Crank Sensor In (from sensor)
() Green A Speed Sensor In

74 Blue A Cam Sensor In (from sensor)
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ECU+ Function Stock ECU

Pin #

] Violet A Ignition 1/4 In 54

A Grey A Injector 1 In 51
10} (White) A Not Used
I8N (Brown) B Not Used
IPA (Black) B Not Used
IB) Red B MAS Out (to stock ECU) 10
I3 Orange B Crank Sensor Out (to stock ECU) 21
I&) Yellow B Analog Output 0
I Green B Analog Output 1
IWA Blue B Knock Sensor In 9
I8 Violet B Analog Output 2
1) Grey B Analog Output 3
p(0} (White) B Not Used
AR Brown C Rear O2 Sensor In N/A
w¥A Black C Reserved
RN Red C Spare Analog Input 1/EGT Adapter In
23 Orange C Reserved
a8 Yellow C External MAP Sensor In
/3 Green C Simulated Rear O2 Sensor Out N/A
¥¥A Blue C Spare Analog Input 2/Wideband O2 Sensor Kit In
il Violet C Spare Analog Input 0
28 Grey C Coolant Temperature Sensor In 20
R0 White C Reserved
I8 Brown D Reserved
kA Black D Front O2 Sensor In 4
fRN Red D Air Temperature Sensor In
RZY Orange D Throttle Position Sensor In 19

Table 1- The low current harness connections

With the exception of the MAS, crank and cam sensor connections, all of the above
connections are tap connections — you “tap” the signal and feed it to the ECU+ input. For the
MAS, crank and cam sensor connections, you'll split the stock ECU's wire and connect the
vehicle sensor's output to the ECU+, and the corresponding ECU+ output to the stock ECU.

The high current harness connector contains 18 positions. Of this, only 6 positions are used.
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The table below lists the connections on the high current harness, and where they'll connect
to on the stock ECU. Note that the connections on the high current harness are numbered
from right to left rather than from left to right, as on the low current harness.

ECU+ ECU+ ECU+ Function Stock ECU
Pin#  Wire Pin #
Color
I8 Red +12v Power 101
A Black | Ground 102

) Grey Reserved
) White  Reserved
IWA Violet  Reserved

I8 Green | Reserved

Table 2- The high current harness connections

ECU+ pins 1 and 2 are tap connections.

4 other connections are reserved for future use, and will be used in the next software release.
The rest of the connections are not used.

Some notes:

® The 1990-1994 cars don't include a rear O2 sensor, so these connections are marked N/A
in the low current table. The input marked Rear O2 Sensor In can be used as an
additional 0 to 5 volt analog input, if desired.

® Some connections on both harnesses are marked reserved. These will be used in a future
ECU+ software release.

e Any ECU+ harness connections that aren't wired up to the stock ECU or another device
should be securely bundled together with electrical tape on the end to ensure that these
don't accidentally short-circuit to a in-car ground.

With the basic ECU+ installation completed, you may want to consider hooking up the
simulated rear O2 sensor signal, an external MAP sensor (for boost datalogging), an external
wideband O2 sensor, or any of the ECU+'s analog inputs or outputs. See the section Using
the Auxiliary ECU+ Inputs and Outputs on page 16 for more information.

Now skip to the section Finishing Up the Hardware Installation, on page 20.

5.4.2 1995 and Up Talon, Eclipse and Evolution Vlil, PnP ECU+

On the 1995-1999 Talon and Eclipses, and the Evolution VIlII, the stock ECU contains four
connectors, numbered as shown in Illustration 3. This view shows the stock ECU as you'll
view it, facing the connectors, facing the connectors in the end of the metal enclosure.
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To install the plug-n-play (PnP) version of the ECU+, simply unplug the stock connectors from
the stock ECU, and plug them into the mating connector on the ECU+ wiring harness. The
ECU+ wiring harness contains a similar set of connectors — plug these into the stock ECU.
Each of the connectors are different sizes and keyed for orientation — it's not possible to mix
them up.

Note: any ECU+ harness connections that aren't wired up to the stock ECU or another device
should be securely bundled together with electrical tape on the end to ensure that these don't
accidentally short-circuit to a in-car ground.

With the basic ECU+ installation completed, you may want to consider hooking up the
simulated rear O2 sensor signal, an external MAP sensor (for boost datalogging), an external
wideband O2 sensor, or any of the ECU+'s analog inputs or outputs. See the section Using
the Auxiliary ECU+ Inputs and Outputs on page 16 for more information.

Now skip to the next section, Finishing Up the Hardware Installation, on page 20.

5.4.3 1995 and Up Talon, Eclipse and Evolution VIil, non-PnP ECU+

On the 1995-1999 Talon and Eclipses, and the Evolution VIlII, the stock ECU contains four
connectors, numbered as shown in lllustration 4. This shows the stock ECU as you'll view it,
facing the connectors in the end of the metal enclosure .
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Adr Temperature 5 ensor
Rear O2 Sensor

Ignition 1/4 Fromt O2 3 ensor
Injector 1 +12v Power Enock Bensor
Grownd
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Throttle P ositiond ensor
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Hllustration 4- The second generation DSM and EVO VIII ECU pinout

To hook up the ECU+ head unit, you'll be wiring between the stock ECU and one of the two
ECU+ harnesses. There are two ECU+ harnesses — one for “low current” connections (this is
the main harness, containing 34 pins, terminated at the black connector on the head unit) and
one for “high current” connections (terminates at the white connector on the head unit). The
high current harness also includes the power connections.
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lllustration 5 - The low (left) and high (right) current harnesses.

The low current harness connector contains 34 positions arranged in groups of ten. The
groups are labeled “Group A” through “Group D,” and within a group, wires are color-coded in
the following sequence: brown, black, red, orange, yellow, green, blue, violet, gray, white. In
the above illustration, the Group A wires are on the left, then Group B, Group C and Group D.
The leftmost brown wire in Group A is pin 1. Underneath pin 1 is the unused pin 2. The red
wire beside the brown wire is pin 3, and so on. The table below lists all of the connections on
the low current harness, and where they'll connect to on the stock ECU. Note that some
positions on this connector are unused (like pin 2), and there is no wire in that position.

ECU+ Function Stock ECU
Pin #

I§ Brown A Sensor Ground 92
v (Black) A Not Used

£ Red A Cam Sensor Out (to stock ECU) 88
Z¥ Orange A MAS In (from sensor) Was 90
ol Yellow A Crank Sensor In (from sensor) Was 89
) Green A Speed Sensor In 86
74 Blue A Cam Sensor In (from sensor) Was 88
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ECU+ Function Stock ECU

Pin #

] Violet A Ignition 1/4 In 10

) Grey A Injector 1 In 1
10} (White) A Not Used
I8N (Brown) B Not Used
IPA (Black) B Not Used
IB) Red B MAS Out (to stock ECU) 90
I3 Orange B Crank Sensor Out (to stock ECU) 89
I&) Yellow B Analog Output 0
I Green B Analog Output 1
IWA Blue B Knock Sensor In 78
I8 Violet B Analog Output 2
1) Grey B Analog Output 3
p(0} (White) B Not Used
AR Brown C Rear O2 Sensor In 75
v Black C OBD-II Data In 62
RN Red C Spare Analog Input 1/EGT Adapter In
23 Orange C Reserved
a8 Yellow C External MAP Sensor In
/3 Green C Simulated Rear O2 Sensor Out
¥¥A Blue C Spare Analog Input 2/Wideband O2 Sensor Kit In
il Violet C Spare Analog Input 0
ol Grey C Coolant Temperature Sensor In 83
R0 White C Reserved
I8 Brown D Reserved
kA Black D Front O2 Sensor In 76
RN Red D Air Temperature Sensor In 72
3 Orange D Throttle Position Sensor In 84

Table 3- The low current harness connections

With the exception of the MAS, crank and cam sensor connections, all of the above
connections are tap connections — you “tap” the signal and feed it to the ECU+ input. For the
MAS, crank and cam sensor connections, you'll split the stock ECU's wire and connect the
vehicle sensor's output to the ECU+, and the corresponding ECU+ output to the stock ECU.

The high current harness connector contains 18 positions. Of this, only 6 positions are used.
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The table below lists the connections on the high current harness, and where they'll connect
to on the stock ECU. Note that the connections on the high current harness are numbered
from right to left rather than from left to right, as on the low current harness.

ECU+ ECU+ Function Stock ECU
Wire Pin #
Color
I8 Red +12v Power 12
A Black | Ground 13
) Grey Reserved
) White  Reserved

IWA Violet  Reserved

I8 Green | Reserved

Table 4- The high current harness connections

ECU+ pins 1 and 2 are tap connections.

4 other connections are reserved for future use, and will be used in the next software release.
The rest of the connections are not used.

Some notes:

® Some connections on both harnesses are marked reserved. These will be used in a future
ECU+ software release.

e Any ECU+ harness connections that aren't wired up to the stock ECU or another device
should be securely bundled together with electrical tape on the end to ensure that these
don't accidentally short-circuit to a in-car ground.

With the basic ECU+ in stallion completed, you may want to consider hooking up the
simulated rear O2 sensor signal, an external MAP sensor (for boost datalogging), an external
wideband O2 sensor, or any of the ECU+'s analog inputs or outputs. See the section Using
the Auxiliary ECU+ Inputs and Outputs on page 16 for more information.

Now skip to the section Finishing Up the Hardware Installation, on page 20.

5.5 Using the Auxiliary ECU+ Inputs and Outputs

The ECU+ contains a number of additional inputs and outputs that add value to a standard
installation. Included are a simulated rear O2 sensor output and several analog inputs and
outputs. These are covered below.

5.5.1 The Simulated Rear O2 Sensor Output

Note: This section is not applicable to 1990-1994 DSMs, as those vehicles only include a
front O2 sensor.

The 1995 and up Talons, Eclipses and Evolution VIl vehicles include a rear O2 sensor on
the far side of the catalytic converter. The stock ECU checks this signal to verify that the
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vehicle has a functional catalytic converter. If the cat is removed for race purposes, the rear
02 sensor signal won't respond as the stock ECU expects, and will often trigger a “check
engine” light to flag the problem. The ECU+ head unit includes a simulated rear O2 output
(for off-road use only) that can eliminate this problem. The signal simulates the signal that
the stock ECU will see from a functional rear O2 sensor, and thus avoids the check engine
light.

To connect the simulated rear O2 signal, locate pin 26 (green, Group C — see Table 3) on the
ECU+'s low current harness. Then locate pin 75 on the stock ECU (see lllustration 4) which
should be tapped with a brown wire to the ECU+ head unit's rear O2 sensor input. Cut the
stock ECU wire between the stock ECU's male connector and where it splices into the brown
wire, and solder in the simulated rear O2 signal to the wire containing the splice. This feeds
the ECU+'s simulated rear O2 sensor output to the stock ECU, and eliminates the check
engine light.

Note: in the previous paragraph, if you've purchased a PnP ECU+, the connection should be
made in the ECU+'s PnP harness, not in the stock ECU wiring.

5.5.2 Analog Inputs

The ECU+ includes three uncommitted analog inputs whose voltage is logged along with all
of the other ECU+ inputs. These are high impedance (2M ohm resistance) inputs that can
accept any signal between 0 and 5 volts. Many aftermarket vehicle sensors can be
configured to produce a “5 volt” output, and you can datalog these values with the ECU+.

Warning: before connecting a sensor input to an ECU+ analog input, verify (using a digital
multimeter) that the sensor doesn't generate less than zero or greater than 5 volts.
Connecting an out-of-range sensor can damage or destroy your ECU+ head unit.

To connect up a 5 volt input, simply wire it directly to the appropriate ECU+ input. Spare
input O is pin 28 (violet wire, Group C) on the ECU+, spare input 1 is pin 23 (red wire, Group
C) and spare input 2 is pin 27 (blue wire, Group C).

Spare input 2 includes an additional function. The ECU+ software is pre-calibrated to display
air-fuel ratio when a supported wideband O2 sensor kit is connected to this input. See Using
a Wideband O2 Sensor Kit on page 18 for more information.

5.5.3 Analog Outputs

The ECU+ includes four uncommitted analog outputs that can generate any fixed voltage
between 0 and 5 volts under software control. Two of the four outputs are used when the
ECU+ is used with a GM MAF device, but otherwise these outputs are unused and can be
used to control some other device that needs a fixed voltage. Note that these analog outputs
aren't fully buffered on the ECU+, and connecting them directly to ground may damage your
ECU+ head unit. It's recommended that any device that connects to these outputs have an
input impedance of 10k ohms or greater.

5.5.4 Using a MAP Sensor

The ECU+ directly supports several aftermarket MAP sensors using a dedicated input. A
MAP (Manifold Absolute Pressure) sensor allows the ECU+ to directly datalog and read out
your car's boost level.

The ECU+ currently supports three different MAP sensors:
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The “GM 3-Bar” map sensor (part number 12223861), available from any GM dealer or GM
Parts Direct (http://www.gmpartsdirect.com).

The SenSym ASCX30 two-bar map sensor, available from DigiKey
(http://www.digikey.com).

The AEM 3.5 Bar map sensor, available from many AEM dealers.

Each of the sensors has a port for pressure, and at least three electrical connections, with
one terminal for a +5 volt power source, one for ground, and one for the output voltage. Install
the sensor's pressure input just like you would a boost gauge, and then connect a long wire
from the sensor output in the engine bay, through the firewall, and to your ECU+'s MAP
sensor input pin (pin 25, yellow wire, Group C). You'll need to locate a +5 volt source under-
hood for the sensor, which is available by tapping any of several of the stock engine sensors.

For the GM sensor, make the electrical connections as follows:
'A' terminal to ground
'B' terminal is the sensor output
'C' terminal to a +5v voltage source

The SenSym sensor has six electrical pins. With the sensor laying flat on a table (pressure
port facing up, electrical pins at the bottom), the pins are numbered 1-6 from left to right.
Make the electrical connections as follows:

Pin 2 to a +5v voltage source
Pin 3 is the sensor output
Pin 4 to ground

The AEM sensor has three electrical connections. Looking into the end of the sensor, with
the tab at the top, the connections are as follows:

Upper left pin to a +5v voltage source
Upper right pin to ground
Bottom pin is the sensor output

Be very careful when installing a MAP sensor. Use a digital multimeter to verify your +5 volt
source, and under no circumstances connect the MAP sensor to +12 volts. Doing so may
damage the sensor and/or your ECU+ head unit.

5.5.5 Using a Wideband O2 Sensor Kit

The ECU+ supports a number of wideband O2 sensor kits. An O2 sensor “kit” uses an off-
the-shelf wideband oxygen sensor along with some electronics to control the sensor heater
and to condition and linearize the output of the sensor. When a supported kit is connected to
the ECU+, the ECU+ can capture and display a real-time graph of your engine's air/fuel ratio.
This is very useful when adjusting fuel with the ECU+.

The ECU+ Palm and Windows software supports the following wideband kits:

PLX Devices M-Series (M-200, M-250, M-300, M-400 and M-500) Wideband Oxygen
Sensor Controllers, with or without the M-Series gauges. See http://www.plxdevices.com
for more information.

FJO Racing Wide Band Oxygen Sensor kits using controller CWC0002 or CWCO0001. See
http://www.fjoracing.com.

Page 18



Innovative Motorsports LM-1 Air/Fuel Gauge. See http://www.innovativemotorsports.com.
Tech Edge WB02 Lambda Meters (WBo2 version 2A0 and TE-WB Wideband Unit (v1.5)).
See http://www.techedge.com.au.

Zeitronix Zt-2 Wideband Air/Fuel Ratio Meter. See http://www.zeitronix.com.

AEM Wideband UEGO Controller and Gauge-Type Wideband UEGO Controller. See
http://www.aempower.com.

To use a wideband kit with the ECU+, first install the device as described by the
manufacturer, to include any calibration sequences. Next, connect the output of the
wideband controller to the spare 2 analog input on the ECU+. This is pin 27 (blue wire,
Group C) on the ECU+ head unit. Then configure the software so that the ECU+ knows
which wideband kit you're using (see the section Miscellaneous Configuration on page 44 for
the ECU+ Win software, and the section The ECU+ Palm Setup Screen on page 29 for the
ECU+ Palm software).

Connecting up a wideband is usually pretty straightforward. The main difference between the
the supported kits lie in which wideband output you should connect to the ECU+ head unit:

For the PLX M-Series, use the WB output (white wire).
For the FJO kits, use the red analog output wire on the black 4-pin square connector.

For the Innovative LM-1, a 3.5mm stereo connector provides the output that the ECU+
needs. Pin 1, the connector tip, is analog output 1. Connect this to the ECU+ head unit.

For the Tech Edge 2A0, use the WBIin output, which is pin 4 on the unit's RJ45 connector.
Facing the RJ45 connector, the pins are numbered 1-8 from left to right.

For the Tech Edge TE-WB 1.5, use the WBIin output, which is pin 4 on the unit's male DB-
9 connector. Facing the DB-9, the top row of pins are numbered 1-5 from left to right.

For the Zt-2, use the Wideband Analog Output. This is the white wire on pin 2.
For the AEM Wideband UEGO Controller, use the orange wire, pin 1 (Sensor #1, 0-5v).
For the AEM Gauge-Type Wideband UEGO Controller, use the white wire, 0-5v output.

For any of the widebands, be sure that the ground for the controller is identical to the ground
on the ECU+ head unit.

When your wideband is configured, be sure to not modify any of the factory settings on it with
respect to the output “curve.” The ECU+ is pre-configured to work with the factory output
voltages on all of the supported widebands.

5.5.6 Using a EGT Sensor and Adapter

The ECU+ supports datalogging of engine exhaust gas temperature (EGT) using a external
EGT probe and the “5V K-type EGT adapter” from o2simulator.com. (See
http://www.o2simulator.com/AEMEGTADAPTER.html). This adapter converts the signal from
a K-Type thermocouple EGT probe into a 0-5v signal which the ECU+ can datalog as actual
exhaust gas temperature.

To use this adapter, first install the adapter and EGT probe according to the manufacturers
instructions. EGT probes typically are screwed into the exhaust manifold. Next, connect the
white wire from the adapter to the spare 1 input on the ECU+ head unit. This is pin 23, red,
group C on the ECU+ wiring harness. Finally, configure the ECU+ Win and/or ECU+ Palm
software to display actual EGT temperature from the spare 1 input rather than the default
voltage. The ECU+ is pre-configured to work with this adapter to display actual exhaust
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temperatures.

5.6 Finishing Up the Hardware Installation

When you're all done making the ECU+ connections, you'll have some unused wires in both
the analog and digital connectors. Tie these wires together with wire ties and wrap them in
electrical tape. Next, secure all of the ECU+ harness wire bundles by applying wire ties to
each bundle. In particular, be sure to use a wire tie very near each of the connectors at the
head unit — this will ensure that there's no stress on the pins in the cables.

For the non-PnP ECU+, you'll want to verify that you've wired the ECU+ power correctly.
Using a multimeter, hook up to the ECU+ two-pin power connection and turn your car's
ignition to the on position. Your multimeter should read between positive 12 and 15 volts. If
not, double-check your connections. With the wiring completed, you should plug the ECU+
head unit into the newly-wired harnesses.

Next, connect the included 9-pin serial cable to the appropriate connector on the ECU+ head
unit.

Before starting your car for the first time, install the ECU+ software and follow the instructions
in the next few sections to use either the Palm or the Windows software to setup the ECU+
head unit. In particular, be sure that the cam and crank angle sensor types are set
appropriately for your car. Once everything is configured correctly, turn off your ignition and
leave it off for a few seconds, then start your vehicle. The vehicle should run normally, just
like it did before you installed the ECU+. If not, see the next section for troubleshooting
information.

5.7 Troubleshooting the Hardware Installation

In the previous section, you installed your ECU+ head unit. Here are some things to check if
your car doesn't run normally after the install.

- For all problems, double- and triple-check the wiring. Un-tape the connections and look at
them. Is a good solder joint being made? Are the wires connected according to the
tables?

- If your car won't start, chances are that either the cam or crank angle sensor signals aren't
working. Verify that the head unit is using the proper signal type. As a last resort, remove
the ECU+ head unit from its connectors and manually jumper together the cam and crank
sensor signals.

- If the car idles very fast and seems to be running rich, the MAS signal is probably not being
regenerated. Again, check the wiring. Does the software indicate that the input MAS
signal is 0 Hz? If so, the MAS input may be disconnected. If not, the MAS output may be
disconnected.

As a last resort, contact your ECU+ dealer and see what suggestions they might have. The
ECU+ is tested at the factory, and should work for your car.

6 Software Installation
The ECU+ system contains three pieces of software which need to be installed:

e The ECU+ Win software, which is a graphical Microsoft Windows-based display, tuning
and analysis tool.
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e The ECU+ Palm software, which provides a graphical interface on your Palm device for

display and tuning of the ECU+ head unit.

e The ECU+ Palm conduit, which allows the Palm organizer to HotSync data between it and

your PC/laptop running ECU+ Win.

To install the software, insert the CD-ROM supplied with the system into your CD-ROM drive.
Then use the Windows Explorer tool to navigate to the CD-ROM, and double-click the

Setup.exe program.
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'-\_ '_‘] . 3 re
| @ Back - L= B ? 7 Search Ii Folders Address II\_*_) Ll j Go
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lllustration 6 - Installing from CD

The ECU+'s text-based install will begin, and you'll be prompted for a directory to install the
software to. Enter a suitable directory, and the installer will install the software for you. You

should see a screen something like:
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] \W3Zapps' ¥CProjs' EcuPlusApps' Setuphdist’ Setup.exe

elcome to the ECU+ setup.

ECU+ zetup will install all of the ECU+ Windows software to your hard disk.
conf igure the software, and install the Palm conduit and software so that
you'll bhe able to HotSync your ECU+ data files to your computer.

Prezz ENMTER to continue.

Install the software to [C:“Program Files“EcuPlus]l:

Cop
=

wing files...
EcuPluszll.exe
MFC42 _d11
MSUCRT .d11
MEUCF6A.d11
ADUAPI3Z . d11
EcuPluszsPalm.prc
EcuPlusCn.dll
ADUAPIZZ . d11
SYNG2BA._.d11
HELOGZ2A.d11
INSTAIDE.d11
manual . pdf

ok.
ok.
ok.
ok.
ok.
ok.
ok.
ok.
ok.
ok.
ok.
ok.

E
E
E
I
E
E
E
E
I
E
E
E

Samplel _ecd ok.

Creating ECU+ Win desktop shortcut... done.

Creating ECU+ manual desktop shortcut... done.
Creating Windows start menu shortcuts... done.

Setting up Palm PRC file for the next HotSync... done.
Inzstalling Palm conduit... done.

All szoftware successfully installed.

A zhortcut to the ECU+ Win application has heen placed
on your desktop. Doubhle—click it to start ECU+ Win.

To install the ECU+ Palm software, simply HotSync your
Palm organizer and the ECU+ Palm application will he
installed automatically.

Press EMTER to exit the installer. _

lllustration 7 - A successful install

The installer will install the Windows software (ECU+ Win) as well as the Palm conduit. To
install the Palm software (ECU+ Palm), simply HotSync your palm with this computer and the
Palm software will be automatically installed on your Palm organizer. Note: you may need to
restart the Palm Desktop software before starting the HotSync.

7 Using the ECU+ Palm Software

7.1 Introduction

The ECU+ Palm software interfaces to your ECU+ head unit and allows you to tune the
ECU+, perform a capture, or just monitor your engine's sensors.
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7.2 Starting the ECU+ Palm Software

lllustration 8 - The ECU+ Palm icon

To start the ECU+ Palm software, tap its icon (see lllustration 8) on your Palm organizer.
This will start up the ECU+ Palm software, and display its initial screen (see lllustration 9).

lllustration 9 - The ECU+ Palm initial screen

7.3 Changing Screens - The Button Bar

lllustration 10- The button bar

Using the ECU+ Palm software is simple. The software includes four different screens which
allow you to display the engine's sensor values or tune the fuel and timing maps. To switch
between screens, simply tap one of the four buttons along the top button bar (see lllustration
10). Selecting '2' will select screen 2, selecting '3' will select screen 3, and so on.

Each screen serves a particular function:

7.4 Screen 1
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lllustration 11- Screen 1
Screen 1 is a general-purpose sensor display screen with large text. Six sensor values are
displayed here, and the values shown are updated continuously.

lllustration 12- Selecting a sensor

To change which sensors are displayed here, tap the down-arrow button above a given value,
and select a new sensor (see lllustration 12). The ECU+ Palm software will remember how
you've configured this (and other) screens between sessions.

The sensors that you can display are:
® MAS Input - This is the frequency of your MAS (mass-air sensor), as seen by the ECU+
head unit, in Hz. The MAS measures the amount of air entering your engine, where higher
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frequencies indicate more air.

e MAS Output - The frequency of the MAS sensor that the ECU+ sends on to your stock
ECU. The stock ECU uses this value to determine how long to hold open the injectors, and
thus, how much fuel to supply to the engine. Higher output frequencies tell the stock ECU to
supply more fuel. The MAS output frequency is a function of the MAS input frequency, the
current fuel adjustment, the injector scaling value, and the various “MAS tweaks.

e MAS Adjustment - The current adjustment to the MAS output frequency, as a percentage.
You configure the fuel maps that the ECU+ head unit uses, and the head unit changes the
MAS output frequency as you requested. The MAS adjustment shows the current adjustment
that's in effect. Note that the MAS adjustment doesn't include any inherent change in the
MAS output frequency caused by the injector scaling value — that is, if you've got injector
scaling (say 550/660 cc) in effect, and your current fuel map value is -10%, the MAS
adjustment will show -10% even though the MAS output frequency is also affected by the
injector scaling.

® Timing - The current engine timing, as a number of degrees. The engine timing determines
where in the piston revolution that the spark plug fires, and is measured in degrees before or
after top-dead-center (TDC) of the piston. This value is positive if the spark fires before TDC,
and negative if after.

® Timing Adjustment - As with the MAS Adjustment, this is the current timing adjustment (in
degrees) that the ECU+ head unit is using. To adjust the engine timing, the ECU+ head unit
slides the cam and crank angle sensor signals of your engine forward or backward by a
specified number of degrees, and passes these modified signals on to the stock ECU.

® O2 Front - This is the reading of the front oxygen (O2) sensor in your car, in volts. The front
oxygen sensor, normally located just beyond the turbocharger in the exhaust downpipe,
outputs a voltage roughly corresponding to how rich your engine is running. Higher voltages
indicate a richer mixture (more fuel for every molecule of air) while lower voltages indicate a
leaner mixture (less fuel for every molecule of air). This signal is typically between zero and 1
volt, and will switch back and forth between rich and lean when your car is idling or at part
throttle in normal driving situations. Note: when O2 sensors get old or are failing, they often
have little or no output voltage, or are very "slow" to react to changes in fuel mixture. Also, a
lack of voltage can indicate that the heater inside the O2 sensor is defective.

® O2 Rear - The voltage from the rear O2 sensor, if applicable. The rear O2 sensor, when
installed, is on the far side of the catalytic converter (cat), and is often used by the stock ECU
to detect when the cat has been removed or is defective. Removal of the cat will often trigger
a "check engine" light from the stock ECU. Note that the ECU+ head unit can generate a
simulated version of this rear O2 sensor signal, which can be fed to the stock ECU to avoid
the check engine light. This capability is for off-road situations only.

® Engine Speed - Your engine's speed, as a number of revolutions per minute (RPM).

e Air Temp - The temperature of the air entering your engine, in degrees fahrenheit, as
measured by the air temperature sensor. The air temperature sensor is located in the air
intake, and is generally an integral part of the MAS. This temperature readout here will
generally be a bit hotter than the true air temperature outside of your car.

e Coolant Temp - The temperature of the coolant in your engine, as measured by the coolant
temperature sensor.

e TPS - The voltage from your engine's throttle position sensor. The TPS measures how far
you've pressed on the accelerator, as a voltage between zero and 5 volts. The ECU+ head
unit considers a voltage above 4 volts to be wide-open-throttle (WOT), or below 0.75 volts to
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be closed throttle.

® Boost - Your turbocharger boost level, in pounds per square inch (PSI). Note that this
reading requires an optional MAP sensor. If you haven't installed a MAP sensor, this reading
will be zero. Typically readings for a car at WOT will be 12-25 PSI, though this value varies
widely depending on your turbocharger.

® Inj Pulse Width - This is the pulse width, or on-time, of your engine's injectors, measured in
milliseconds (ms, or thousandths of a second). To squirt fuel into your engine, the stock ECU
turns on the injectors for a fraction of a second - the longer the injectors are on, the more fuel
is squirted. This value will typically read out around 2 ms at idle, and much more at WOT.

e Inj Duty Cycle - The "duty cycle," or ratio of on-time to total-time, for your engine's injectors.
This is displayed as a percentage. The stock ECU has a fixed amount of time available to it
in which it can squirt the injectors. This fixed time is inversely proportional to the engine RPM
(higher RPMs - less time). The injector duty cycle measures what percentage of the total
time available that the injectors were on. 72% would indicate that the injectors were on 72%
of the time that was available.

® Vehicle Speed - This is the car's approximate speed, as measured by the vehicle's speed
sensor. Note that this is an approximate value that is pretty close for stock vehicles.
However, changing tire or wheel size on your vehicle will affect the accuracy of this read-out.

eKnock Voltage — This is a specially-conditioned version of the output of your vehicle's knock
sensor. The ECU+ head unit uses specialized input and conditioning hardware and software
to monitor the knock sensor, and displays this value as the knock voltage. When your engine
is knocking, you'll see “spikes” on the knock voltage display.

® Spare 0, 1 and 2. These are spare analog inputs to the ECU+ head unit that can be used
for any signal that ranges between zero and 5 volts. The voltage displayed here is the
voltage of these spare inputs, and can be used for things like a wideband O2 sensor or EGT
(exhaust gas temperature) probe adapter. If you've hooked up a wideband O2 sensor to
spare 2, this value can instead display the engine's air/fuel ratio, where 10:1 is very rich, and
20:1 is very lean. If you've hooked up an EGT probe and adapter to spare 1, this value can
instead display the engine's exhaust gas temperature.

7.5 Screen 2
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Hllustration 13- Screen 2

Screen 2 is the catch-all sensor display screen. This screen displays as many of the sensor
values as possible on one screen. As with screen 1, the displayed values are updated
continuously. Tap the scroll bar on the right side to see the rest of sensor values.

7.6 Screen 3

lllustration 14- Screen 3

Screen 3 is the graphing screen. Two sensor values will be graphed here in real time. As
with screen 1, which two sensors you'd like to graph can be selected by tapping the down-
arrow button on the text fields at the top. At the bottom, two sets of buttons are available to
zoom in and out on a graph. The first set of buttons is for the top graph, and the second set
of buttons is for the bottom graph. For each, tap the '+' button to zoom in, and the '-' button to
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zoom out. Tap the up button to scroll the graph upward, or the down button to scroll the
graph downward. Note that the ECU+ Palm software displays exactly 10 seconds worth of
data here in real-time - it's not possible to scroll backwards to see old data.

7.7 Screen 4

lllustration 15- Screen 4

Screen 4 is the tuning screen. Four sensor values are displayed and updated continuously.
In addition, you can use the top section of the screen to display and modify the fuel and
timing maps for your ECU+ head unit. The head unit contains 129 fuel and 129 timing map
“cells” which allow you control your engine's behavior. The fuel and timing map cells are
arranged as follows:

RPM Low Medium High woTt
Idle Not used Not used Not used

1000

1250

1500

2000

7500
7750
8000

Table 1 - The fuel table
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There are 129 cells for both the fuel and timing maps - one for idle, and one each for low,
medium, and high loads, and one for wide-open-throttle (WOT) conditions. Each of these
can be set individually - the fuel maps cell values can range from -50% to +50%, and the
timing map cell values can vary between -15 degrees and +15 degrees.

To configure a given load and RPM combination, tap the down arrow above the load value to
select a load, and tap the right or left buttons next to the RPM display to select the
combination you want. Then tap the up or down buttons for the fuel or timing table entry you
want to change. Note that the left and right buttons next to the RPM display will cycle through
all of the load and RPM values in order - that is, keep tapping the right button to cycle through
all of the low load RPMs, then the medium load RPMs, and so on.

Screen 4 is particularly useful when tuning your car on a vehicle dyno. You can set the
sensor displays to things that are useful for a dyno run, like RPM, front O2 voltage, air/fuel
ratio, knock and engine timing, and then rev your engine to match a given RPM/load setting.
Then adjust the fuel and timing settings to achieve the air/fuel ratio and engine timing that
you desire.

7.8 The Menu Bar

lllustration 16- The Palm menu bar

The menu bar (see lllustration 16) provides access to the less common screens available in
the ECU+ Palm application. To bring up the menu bar, tap the Palm's menu key. From the
menu bar, various setup, OBD and help screens are available.

7.8.1 The ECU+ Palm Setup Screen
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lllustration 17- The ECU+ Palm setup screen
The ECU+ Palm setup screen lets you configure several parameters related to the ECU+
Palm application:

- Spare 1 Function — The spare 1 analog input can be used as a general-purpose 5 volt
input, or it can be hooked to a EGT adapter which converts the signal from an EGT probe
into a 5v signal. Select Voltage here to use spare 1 as a general-purpose input, or select
5v EGT Adapter to use this input with an adapter.

- Spare 2 Function — The spare 2 analog input can be used as a general-purpose 5 volt
input, or it can be hooked to a variety of supported wideband O2 sensors. Select Voltage
here to use spare 2 as a general-purpose input, or select the wideband sensor kit if you're
using this input for air/fuel ratio display.

« MAP Sensor Type — To display and capture boost, the ECU+ requires an external MAP
sensor. Three map sensors are currently supported:

The “GM 3-Bar” map sensor.
The SenSym ASCX30 two-bar map sensor,.
The AEM 3.5 bar map sensor.

To change any of these parameters, tap the down arrow next to the value. Tap the Done
button when you're finished.

Note that each of these parameters change how the ECU+ Palm application interprets the
spare 1, spare 2 and boost voltages, respectively. You'll need to make matching changes to
the ECU+ Win software.

7.8.2 The Head Unit Setup Screens

The other setup screens available from the menu bar will be discussed in the section
Configuring the ECU+ Head Unit on page 56.

7.8.3 The OBD Screens
The OBD-related screens available from the menu bar will be discussed in the section On
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Board Diagnostics (OBD) on page 67.

7.8.4 The About Screen
The about screen displays the version number of the ECU+ Palm software.

7.9 Capturing Data

The ECU+ Palm software can capture and store away "datalogging" information from the
ECU+ head unit. These captures grab all of the engine sensor values 25 times per second
and store them away in a Palm "database" which can be viewed, or more importantly,
HotSync'd to a PC for use with the ECU+ Win software.

To start capturing data, tap the Capture button located at the bottom of each screen. The
ECU+ Palm software will begin capturing data and display a status box that shows how many
seconds of data have been captured so far.

lllustration 18- The capture dialog

Tap the Done button to save the captured data, or Cancel to discard it. Note that the Palm
software saves captured data to a one-up database filename, which will match the filename
(with a .ecd extension) when this data is HotSync'd to a PC.

7.10 Displaying Captured Data

The ECU+ Palm software contains a simple viewer for displaying captured data. To invoke
the viewer, tap the Display button at the bottom of each screen. This will invoke a display
data dialog in which you can display the contents of a capture.

Page 31



Illustration 19- The data display dialog
Tap the down arrow next to Select a File, and then select the Palm “database” you'd like to
display. This will display the captured data in a simple columnar format, with a scroll bar that
can be used to move up and down in the data. The viewer can display six sensor values
(plus elapsed time) at once, and you can select which columns you'd like to see by tapping
the Columns button and selecting the appropriate sensors. As with all of the other ECU+
Palm screens, your column selections will be remembered between sessions.

Tap the Done button when you've finished viewing a database.

7.11 Upgrading the ECU+ Palm Software

Occasionally, there will be updates to the ECU+ Palm software posted on the ECU+ web site.
To take advantage of these updates, download the software and extract the .zip file to a
temporary location on your laptop. You'll find a file called EcuPlusPalm.prc. Drag and drop
this file into the Palm Desktop's Quick Install tool, and next time you HotSync your Palm with
your laptop, the new ECU+ Palm software will be automatically installed on your Palm.
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lllustration 20- The Palm Quick Install tool

7.12 HotSync'ing Captured Files to Your PC

When you do a capture via the ECU+ Palm software, the captured data is stored in your
Palm as a Palm database. These databases will be automatically transferred from the Palm
to your laptop whenever you do a HotSync operation. If you've installed the Palm Desktop
software in the standard place on your laptop, you'll find these captured data files in the
directory:

C:\Program Files\Palm\LastnameF

where LastnameF is your last name and first initial.

8 Using the ECU+ Win Software

8.1 Introduction

The ECU+ Win software, like the ECU+ Palm software, interfaces to your ECU+ head unit
and allows you to tune the ECU+, perform a capture, or just monitor your engine's sensors.
Unlike the Palm software, though, the ECU+ Win software also includes advanced data
analysis and display capabilities that allows you to easily and accurately configure the ECU+
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head unit to make your car perform at peak levels.

8.2 Starting the ECU+ Win Software
To start the ECU+ Win software, double-click the icon on your desktop.

ELE
A

ECLH+ Wi

lllustration 21- The ECU+
Win icon

The ECU+ Win software should start up and display its main screen (see lllustration 22).

=180

HlEEaE] 2?9 P69

Ready [ hom [
lllustration 22- The ECU+ Win main screen

Because of the amount of information that the ECU+ Win software can display, you might
want to maximize the application.
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8.3 A Guided Tour of the Software

The ECU+ Win application is a relatively complex piece of software. Let's take a look at it
one section at a time.

8.3.1 The Menu Bar

File Miew Settings OBED Help
Illustration 23 - The menu bar

The menu bar (see lllustration 23) is at the top of the screen, and includes the usual
Windows File, View, Help and other menu items. The menu bar will change slightly
depending on what you are doing, but will always include File, View and Help. The sub-
menus that are available on the menu bar are as follows:

8.3.1.1 The File Menu

*! ECU+ Win

|File Yiew Settings CBD Help

Mew Capture

Cpen Existing Capture. .. Chrl+0

Prink Setup. ..

1 Baseline run.ecd

Exit

lllustration 24- The file menu

The file menu (see lllustration 24) is used to Open, Save, Close or Export a capture file, to
start a New capture, or to exit the ECU+ Win application. You can also print the contents of a
graph (discussed later in this manual) from the file menu. Depending upon what you're doing
with the ECU+ Win software, one or more of the items on the file menu may be grayed out or
not available.

The items on the file menu are as follows:

® New Capture - This connects to the ECU+ head unit and begins capturing data from it,
while displaying the data in real time. This is equivalent to the Palm software's Capture
button. Use this menu item to capture new data from your car.

® Open Existing Capture - This opens up an existing file on disk containing captured data,
and displays the data for viewing or analysis. Use this menu item to display previously-
captured data.

e Close Capture - When doing a new capture, this finishes the capture and prompts to save
the data to disk. When viewing an existing capture, this closes the capture file and prompts
to save the data if it's changed.

® Save Capture - This saves any changes you've made to an open capture file, but doesn't
close the file.

® Export Capture - This allows you to export the currently open capture to a new file, in
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comma-separated value (CSV) format. You'll be prompted for the name of the new file. CSV
is a common format that can be read by many applications. Most often, you'll use a
spreadsheet program (like Microsoft Excel) to read a CSV file for complex analysis and
processing.

® Print - This prints the current graph view.
® Print Preview — Previews the graph view before printing.
® Print Setup - Lets you to configure your printer margins and other settings.

e Numbered files - The ECU+ Win software remembers the names of several recent capture
files that you've opened, and displays them with a number next to them. Selecting a
numbered file opens that file quickly, without going through the Open Existing Capture menu
item.

® Exit - This exits the ECU+ Win application, and prompts to save any unsaved capture files.

8.3.1.2 The View Menu

*! ECU+ Win
File | Wigw Settings €
®

v Skakus Bar

lllustration 25- The view menu

The view menu (see lllustration 25) allows you to toggle on and off the toolbar and status
bars for more on-screen real estate. Simply select a menu item to toggle it on and off.

8.3.1.3 The Window Menu

*! ECU+ Win - OrigCal.ecd
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More Windows., .,

lllustration 26 - The window menu

The window menu (see lllustration 26) allows you to arrange the windows in the display area.
Cascade, Tile and Arrange Icons work as in other Windows software, but Auto Arrange is
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unique, tiling the visible view windows in a sensible manner. The numbered windows on this
menu makes the selected window current (in front) and un-minimizes it if necessary. The
More Windows dialog does the same thing, but is used when more than 9 windows are
shown in the display area.

Note that the Window menu will only be available when displaying an existing capture file or
capturing data to a new file.

8.3.1.4 The Settings Menu

“ECU+ Win

File Wiew | Settings ©BD . Help

lllustration 27 - The settings menu

The Settings menu (see lllustration 27) allows you to configure the ECU+ Win software as
well as the ECU+ head unit. Select either from the menu, and then follow the instructions
below for setting each up.

8.3.1.5 The OBD Menu

" ECU+ Win

File View Settings | OBD Help

$ I B | =l Information. ..
Stored Trouble Codes. ..
Pending Trouble Codes...

Clear Trouble Codes Chrl+T

lllustration 28 - The OBD menu

The OBD menu (see illustration lllustration 28) invokes the OBD functionality of the ECU+.
This functionality will be discussed in the section On Board Diagnostics (OBD) on page 67.

8.3.1.6 The Help Menu

The Help menu has a single menu item which displays the About dialog for the ECU+ Win
application. The about dialog just displays the software version and copyright information.

8.3.2 The Toolbar

s

YRR EEEE

lllustration 29- The toolbar

The toolbar (see lllustration 29) is a quick way to access various ECU+ Win menu items with
just a single click. The items on the toolbar, and the menu item equivalences are (from left to
right):
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® New Capture - The record icon. This begins capturing data from the ECU+ head unit. This
is equivalent to File->New Capture.

® Pause Capture - The pause icon. This button temporarily pauses the current capture so
that you can scroll back and look at old data. Click this button once to pause the capture,
and then again to restart the capture. Any data received from the ECU+ head unit while the
capture is paused is lost. There is no menu item equivalent to this button.

e Close Capture - The stop icon. This closes a new capture or existing capture file, and
prompts to save the data if it's changed. This is equivalent to File->Close Capture.

® Open Existing Capture - The open folder icon. This opens an existing capture file for
analysis. This is equivalent to File->Open Existing Capture.

® Save Capture - The floppy disk icon. This manually saves the current capture if it's
changed. This is equivalent to File->Save Capture.

® Setup Head Unit - The hammer icon. This brings up the dialog box to configure the ECU+
head unit's fuel and timing maps and other parameters. This is equivalent to Settings-
>ECU+ Head Unit.

® Add Overlay - The two-graph icon next to the hammer icon. This adds a new overlay to the
current capture file for comparison purposes. This is equivalent to Graph Context Menu-
>Qverlaid Plots->Add New.

e Overlay Shifting - The next four icons (which show a graph and an arrow) are shortcuts
used for shifting the most recent overlay to the left or right. The icons represent shifting left
1/4 page, left by one, shift right by one, and right by 1/4 page, respectively. These are
equivalent to Graph Context Menu->Overlaid Plots->Shift Last.

e Graph Zooming - The next four icons (magnifying glass-like) are used to zoom a graph's X
or Y axis in or out, and are equivalent to Graph Context Menu->Zoom X(Y) Axis->In(Out).
They zoom the current graph out on the X axis, in on the X axis, out on the Y axis and in on
the Y axis, respectively.

® Dyno Analysis - The dyno icon. This brings up the dyno analysis dialog. This is equivalent
to Graph Context Menu->Analyze->Dyno Analysis.

® Help - The question mark icon. Displays the current ECU+ Win “About" dialog. This is
equivalent to Help->About ECU+ Win.

Note that the toolbar can be toggled on and off with the View->Toolbar menu item. If you
never use the toolbar, you may want to turn it off.

8.3.3 The Status Bar

I Ready [cap MM [ScRL ,;gl

lllustration 30- The status bar

The status bar (see lllustration 30) is used to display the settings of the keyboard caps-lock
(CAP), num-lock (NUM) and scroll lock (SCRL) keys, as well as longer descriptions of menu
items. The status line can be safely turned off with the View->Status Bar menu item.

8.3.4 The Display Area
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lllustration 31- The display area

The display area makes up the bulk of the ECU+ Win's screen space. Inside the display
area, the software will display “views” of a live or captured data file. A view is just a sub-
window in which data is displayed. Views will either be text boxes, containing data values
numerically, or graphs showing data in graph form. More information on views is available in

section Setting Up Views on page 49.

8.4 Creating a New Capture

*! ECU+ Win

Filz Wiew Settings OBD Help

=
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lllustration 32 - The new capture menu item
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The ECU+ Win software can capture and store away "datalogging" information from the
ECU+ head unit. These captures grab all of the engine sensor values 25 times per second
and store them away in a file on your computer's hard disk. This captured data contains a
permanent record of your engine's operation, and can be later loaded back into the ECU+
Win software for analysis or comparison to other captures.

To create a new capture file, use the File->New Capture menu item, or click on the record
icon in the toolbar. The ECU+ Win software will then open up the serial port and try to
connect to the ECU+ head unit. Once the connection is established, the software will open
up the views that you've configured and begin capturing data from the head unit. While the
capture is going on, you can open, close or resize any of the views in the display area. At
any point during the capture, you can use File->Close or click the stop icon in the toolbar to
stop capturing. When you stop capturing, ECU+ Win will prompt for you to save the file, and
display the standard Windows file-save dialog. At any point during the capture, you can also
pause the capture by clicking the pause icon in the toolbar. Any data accumulated from the
head unit while paused will be lost.

8.5 Opening an Existing Capture File

| Ele Wiew Settings OED Help
Chel+H
Dpen Existing Capture,., St
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lllustration 33 - The open existing capture menu item

Captures that you've acquired with either the ECU+ Win or the ECU+ Palm software can be
loaded into ECU+ Win by “opening” an existing capture file. To do this, use either the File-
>0Open Existing Capture menu item, or click the open folder icon on the toolbar and select the
capture file you'd like to view. ECU+ Win will open this file and display its contents within the
views you've configured. When you're done with this capture, use File->Close capture to
close it out.

Note: Only one capture file can be open at a time. You can, however, overlay one capture on
top of another. See the section Overlaying Multiple Capture Files on page 50 to see how this
powerful technique works.

8.6 Configuring the ECU+ Win Software
To configure the ECU+ Win software, use the Settings->ECU+ Win menu item. This opens

the ECU+ Win configuration dialog. This has four tabs:

8.6.1 View Configuration
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lllustration 34- The view configuration tab

The view configuration tab tells the ECU+ Win software what views you'd like to see by
default. When you start a new capture or open an existing capture file, the ECU+ Win
software starts up and displays one or more views of the data associated with this capture. If
Remember which views were active is checked, the ECU+ Win software will display the same
set of views that were active the last time you showed a capture. If this is un-checked, the
checked views will be shown instead,

The checkbox Remember window positions, sizes and zooms determines whether the ECU+
Win software will restore the views in the same window position, minimized status, and
overlap as before.

Lastly, the Initial plot time text field sets how many seconds the X axis of the graph views will
display by default.

8.6.2 Notes Configuration
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lllustration 35- The notes configuration tab

The Notes configuration tab allows you to configure which notes get added to new captures
by default. When you start a new capture, the ECU+ Win software automatically copies the
values defined here into the notes view for that capture. You can add or delete values from
this dialog to configure what notes are used by default. If a field named “Date” and/or a field
named “Time” is defined here, it's filled in by the ECU+ Win software when the new capture is
started.

Double-click a field name or value to change it, and then press ENTER.
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8.6.3 Communications Configuration
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lllustration 36- The communications configuration tab

The communications configuration tab sets up what serial port your laptop will use when
talking to the ECU+ head unit. Typical values used are COM1 (with a laptop that has a “real”
serial port), or COM5 (with a laptop using a USB-to-serial adapter). Click the dropdown arrow

to change this value.
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8.6.4 Miscellaneous Configuration

ECU+ Win Settings N x|

iews I Moates i Communications  Miscellaneous i

Spare 1 uzed as
Spare 2 uzed az

MAP zenszor tupe

|5 EGT Adapter

| PL< wideband 02

Yoltage

PL wideband 02
FJO wWideband 02
iLM-T wideband 02
TE “B1.5Wideband 02

TE 240'wideband 02
Zeitronis 27T 2 Wideband 02
AEM Contraller wWideband 02
AFEM Gauge Wideband 02

2]
i

k. I Cancel Spply

lllustration 37- The miscellaneous configuration tab

The miscellaneous configuration tab lets you configure several miscellaneous parameters:

Spare 1 Function — The spare 1 analog input can be used as a general-purpose 5 volt

input, or it can
into a 5v signa

be hooked to a EGT adapter which converts the signal from an EGT probe
|. Select Voltage here to use spare 1 as a general-purpose input, or select

5v EGT Adapter to use this input with an adapter.

Spare 2 Function — The spare 2 analog input can be used as a general-purpose 5 volt

input, or it can

be hooked to a variety of supported wideband O2 sensors. Select Voltage

here to use spare 2 as a general-purpose input, or select the wideband sensor kit if you're
using this input for air/fuel ratio display.

MAP Sensor Type — To display and capture boost, the ECU+ requires an external MAP

sensor. Three

map sensors are currently supported:

The “GM 3-Bar” map sensor.

The SenSym ASCX30 two-bar map sensor,.

The AEM 3.

5 bar map sensor.

Click the dropdown for one of these to change the current values..

Note that each of

these parameters change how the ECU+ Win software interprets the spare

1, spare 2 and boost voltages, respectively. You'll need to make matching changes to the
ECU+ Palm software.
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8.7 The About Dialog

The About dialog, accessible from the menu item Help->About ECU+ Win, displays the
version of the ECU+ Win software and a copyright notice.

8.8 The Views

When displaying the contents of a captured data file, the ECU+ Win software opens up
multiple views of the data in the display section of the software. There are several types of
views that the software can display. Some views display several values, some are graphs
that can be scrolled around in, and some are just simple text displays. Let's take a look at

them:

8.8.1 The Engine Monitor View
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lllustration 38- The engine monitor view

The engine monitor view (see lllustration 38) is your one-stop shop for everything that the
ECU+ head unit knows about your engine's sensors. It displays a variety of information about
the engine's sensors and what the head unit is doing. When doing a new capture of live

nt data from the engine sensors in real time.
contents of the engine monitor reflect the cursor
he engine monitor displays the current engine data

data, the engine monitor displays the curre
When viewing a capture file from disk, the
position on the current graph view. Thus, t
at all times as a “snapshot” of what's going

Note: the engine monitor is the only view that can't be closed by clicking the 'X' in the upper

right of the window.

8.8.2 The Notes View

on.
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lllustration 39- The notes view

The notes view displays any notes associated with the current capture. You can edit a note's
name or value by double-clicking on the field, making your change, and then pressing
ENTER.

8.8.3 The Plot Color Legend View
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lllustration 40- The plot color 7e'gend view

The plot color legend view (see lllustration 45) is a simple box that shows what colors are
being used in the graph views when multiple files are overlaid.

8.8.4 The Fuel Maps and Timing Maps Views

lllustration 41 - The fuel maps view

The fuel and timing maps can also be displayed in the ECU+ Win software's display area.
These views show the fuel and timing maps as they existed when the current capture was
made. Additionally, the fuel or timing map value that corresponds to the current (new
capture) or cursor (existing capture file) data value is shown highlighted in this view, and this
view will auto-scroll so that the current value is on-screen. Remember that the ECU+ head
unit interpolates between fuel or timing map cell values, so this highlighted value doesn't
necessarily reflect the exact fuel or timing offset that the ECU+ head unit is using — rather, it's
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the closest one. So, for example, if your engine RPM is 3125 RPM, the 3000 RPM map cell
will be highlighted, when in fact the ECU+ head unit is actually using the value about half-way
between 3000 and 3250 RPM.

8.8.5 The Graph Views
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lllustration 42 - A graph view

The graph views are the most complex and powerful of the views to use. A graph view shows
a single value from a capture in an X-Y plot, where the X axis is time, in seconds, and the Y
axis is the single value. Graph views can be moved around, resized and zoomed. Let's see
how these features work:

8.8.5.1 The Cursor and Moving Around

The cursor in a graph view (shown as a small cross that tracks the graph) represents the
“current” spot on a graph. When you hover your mouse over a graph view, the cursor tracks
the horizontal position of the mouse, and pops up a Windows tooltip showing you the current
X and Y axis values of the cursor on that graph. If there are any other graph views displayed,
a similar tracking cursor is displayed which follows the mouse on all of the graphs at the
same time. If you have a engine monitor view active, the values in the engine monitor reflect
the current cursor position.

To move the cursor around on a graph view, simply move the mouse. If you'd like to see
other parts of the graph, you can use the X and Y scroll bars. Note that the X axis of each
graph view is synchronized with the X axis of all of the other graph views.

8.8.5.2 Zooming In And Out

Sometimes a graph view won't reflect exactly the X and Y ranges you'd like to see. The
ECU+ Win software gives you multiple ways of zooming in and out:

® The keyboard shortcuts F8, Shift+F8 and Ctrl+F8 are configured to zoom the X axis in, out,
and to “full size” (as large as it can go), respectively.

e Similarly, F9, Shift+F9 and Ctrl+F9 zoom the Y axis.

e Other zoom options are available in the graph view Context menu (more on this in the next
section).

® And last but not least, you can use the left mouse button to manually zoom to a specific
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range — first, select the upper left corner, and press the left mouse button, then while
holding down the mouse, drag the dotted box to the lower right corner and release the
mouse.

8.8.5.3 Using the Graph Context (RMB) Menu

Each graph view has what's called a “Context” or right-mouse-button menu, which you can
access by right-clicking on the graph. This invokes a new menu:

-
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lllustration 43 - The graph view context menu

The context menu has several items. The first three items apply to the current graph only,
while the remaining options apply to the ECU+ Win software. The menu items are as follows:

8.8.5.3.1 Zoom X Axis and Zoom Y Axis

Use these menu items to zoom the X or Y axis of the graphs. Any X axis changes apply to all
graphs, while any Y axis changes apply to the current graph only. You can zoom each axis
in, out or to full size, or you can set the X and Y axis values to a specific size. The Y axis
zoom has an additional option, “Fit Visible,” which will scale the Y axis to match the visible
data in that graph.

8.8.5.3.2 Undo Last Zoom

This un-zooms the last zoom. The five most recent zooms are remembered, and can be un-
done. Note: this item isn't shown in lllustration 43.

8.8.5.3.3 Refresh
This menu item redraws the current graph.

8.8.5.3.4 Auto Scroll

When capturing new data, this option is enabled. With the option checked, new data will
cause all of the graph views to scroll rightward. If you un-check the option, the graph will not
scroll with new data. Compare this option to the pause icon — pause throws away new data
while keeping the graph stationary, while Auto Scroll keeps the graph stationary while
continuing to acquire new data.

8.8.5.3.5 View and Window List
These menu items will be described in the section Setting Up Views on page 49.
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8.8.5.3.6 Overlaid Plots
This menu item will be discussed in the section Overlaying Multiple Capture Files on page 50.

8.8.5.3.7 Analyze
This menu item will be described in the section Analysis Tools on page 52.

8.8.6 Setting Up Views

After starting a new capture or opening an existing capture file, the ECU+ Win software will
open a collection of views to show you the data associated with the capture. Each view will
open in a window in the display area of the software. You can then use the mouse or the
Windows minimize and maximize buttons to resize each window. You best bet, though, is to
display the views you're interested in, and then use the Window->Auto Arrange menu item to
tile the windows.

If you've minimized a view window, or it's underneath another window and you can't see it,
you can use either the Window menu, and then select a window by number to show it, or
right-click on another window, and select Window List.

To close out a view window, click the 'X' in the window's upper right corner. To display a new
view window, use the right-click context menu, and select View. This will display a sub-menu
that looks like this:
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lllustration 44 - The context view menu
Click an item on this menu to activate or de-activate that view. Views that are checked are
currently displayed, though they may be displayed in minimized view windows.

The key points to remember are:
e Use Context Menu->View to activate a view, or

e Use Window->Window List to un-minimize a view window or display it in front of the other
windows

8.8.7 Overlaying Multiple Capture Files

When displaying a capture file, it's often handy to be able to view several capture files at the
same time for comparison. The ECU+ Win software lets you do just that with the concept of
“overlaid plots.” Here's how it works:
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lllustration 45- The overlaid plots menu
1. Open up an existing capture file, and arrange the view windows the way you like them.

2. Use the right-click context menu on one of the graphs, then select Overlaid Plots->Add
New. The standard Windows file-open dialog will appear. Select another capture file.

3. The ECU+ Win software will overlay this new capture directly on top of the original capture
file, using a different color for each capture on the graph.
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2000
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lllustration 46- Two overlaid captures

4. When you hover the mouse over the graph, the Windows tooltip will display the Y axis
values for all of the overlaid captures. The current capture's value is in parenthesis. You
can switch which capture is current with the TAB and shift-TAB keys.

5. Next use the “Shift Last” menu item (or the more-convenient “Align All for Dyno Analysis”
menu item) to align the two plots in time:
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lllustration 47- Aligning two captures
6. When you're all done, use the “Remove Last” menu item to remove the last capture from
the graph views.

Being able to overlay multiple captures is a very powerful technique to compare your vehicle's
performance before and after a hardware modification or when tuning your car's fuel and
timing via the ECU+ head unit. In the next section, we'll see some more powerful techniques
with the Analysis Tools of the ECU+ Win software.

8.9 Analysis Tools

The ECU+ Win software offers two powerful analysis tools that will help you to tune your car
for best performance. They are the Drag Race Analysis and the Dyno Analysis.

8.9.1 Drag Race Analysis

You can access the drag race analysis from the graph view context menu as Analyze->As a
Drag Race. What this analysis tool does is to treat the capture as though it was a run down a
Ya mile dragstrip, and calculates the elapsed time, vehicle MPH and distance 25 times a
second. Additionally, it'll display typical drag race statistics, like 60' time and 4 mile trap
speed.

To use this tool, select Analyze->As a Drag Race from the graph view context menu. You'll
see a dialog like lllustration 48:
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lllustration 48 - The drag race analysis dialog

With the dialog visible, enter in the approximate start time of the drag race and click the
Calculate button. The ECU+ Win software will try to find a spot past the start time in which
the car was over 60 MPH, and then search backwards to find the time when the car was
stopped. It'll treat the stopped time as the start of the drag race and compute the vehicle's 74
mile performance.

You can use the drag race analysis on a real dragstrip (or a deserted road) to see how your
car was doing at various points in the run, and to compare the car's performance before and
after a modification.

Use the Add Summary to Notes button to remember the values calculated here. This adds
the summary values to the notes view for this capture file.

Some considerations when using the drag analysis:

e The calculations use the vehicle's speed sensor, so if you've got non-stock gearing or tires,
the analysis may not match exactly what you'd get from a real dragstrip run.

e The calculations assume no tire spin, which is fairly accurate for AWD cars. FWD cars will
be less accurate.

8.9.2 Dyno Analysis

The dyno analysis tool, accessible from the graph context menu (Analyze->As a Dyno Pull) or
from the dyno icon on the toolbar, is perhaps the most useful tool in the ECU+ Win software.
What the dyno analysis tool does is to treat a short, single-gear acceleration as a dyno pass.
From the data in the capture file, ECU+ Win will calculate your engine's horsepower and
torque and plot it in an X-Y graph that can be zoomed or printed just like the other graph
views. Here's how to use it:
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. Find a deserted back road where you can do some test runs. The road should be flat and
straight. You'll use a road sign or marker on the road as a “launch” spot.

. Start a new capture on the ECU+ Win software.

. Drive your car along the back road in 2" (or 3", if you have access to a drag strip) gear,
and “lug” the car at the lowest possible RPM. As soon as you pass the launch spot, floor
the accelerator and let the car accelerate to redline. Then coast back down and pull off of
the road.

. Stop the capture and save the file. It may be useful to name the file so that you can easily
recognize it later (“20040301 Run3 — Boost at 19 PSl.ecd”).

. Later at home, or after stopping the vehicle, open this new capture in the ECU+ Win
software, and manually zoom the X axis so that just the acceleration time is visible. This
will be easy to find, as the TPS sensor will show the car at WOT, and pretty much
everything will be increasing with time.

Lo F Axis L4
Zoom Y Axis k
Refresh F7
Auto Scroll

View 4
‘iindow List, ..

Crverlaid Ploks

lllustration 49 - The dyno analysis menu item

As a Drag Race
#s a Dyno Pull

6. Open the dyno analysis as shown in lllustration 49. ECU+ Win will have filled in the start

and stop times from your zoomed graph. Update the other inputs on the left side, and
press the Calculate button. The ECU+ Win software will now display your car's horsepower
and torque graph, just as though you had done a run on a real dyno. See lllustration 50 for
a sample graph.
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lllustration 50 - A dyno analysis

With the dyno analysis done, you can zoom the dyno graph with the mouse, or right-click for
a context menu that has the usual zoom capabilities. You can also print the dyno analysis
with the File->Print menu item. Use the Close button to close the dyno analysis.

The dyno analysis uses the engine's RPM to compute all of its results. Because the vehicle's
speed (and thus acceleration, and thus torque and horsepower) is calculated based on the
car type, car weight, gear used, and tire size, it's important to set these parameters
consistently from one dyno run to the next in order to see reliable plots.

Some things to consider when doing a dyno analysis:

® The dyno analysis uses the Tranny Loss parameter to compute the engine's crank
horsepower from the measured (wheel) horsepower. If you'd like to plot wheel
horsepower, put zero in this field.

e The Smoothing parameter smooths the engine RPM before doing the dyno calculation.
Larger numbers give smoother plots. Generally, values in the 8-12 range work best.

e The ECU+ Win software will remember your dyno analysis parameters from one session to
the next, so it makes sense to put in the correct values for tire size and weight.

o When testing the effects of a performance modification (like a new air filter, or a change in
the fuel maps), it's important to do your “dyno runs” in similar weather, and always use the
same launch point on the road.

® You can overlay two or more captures, and then do a dyno analysis. The dyno analysis
will show you the dyno results from each of the captures, all overlaid on the same dyno
plot. This is incredibly useful when tuning your car. The only caveat is that you must align
the two overlaid graphs such that the dyno analysis time is the same for each. As an
example, if graph 1 did a second gear acceleration starting at 32 seconds, and graph 2

Page 55



started at 28 seconds, you'll need to move the second overlay to the right by 4 seconds.
Use the graph context menu item Overlaid Plots->Shift Last->Align For Dyno Analysis to
do this automatically.

e The dyno numbers are mathematically correct, but may not exactly reflect the numbers
that you'll get on a true vehicle dyno. Nonetheless, what's important is not the absolute
horsepower and torque numbers, but instead that you can see whether changes you make
to your vehicle increase or decrease its performance.

9 Configuring the ECU+ Head Unit

You can use either the ECU+ Win or ECU+ Palm software to configure your ECU+ head
unit's settings. ECU+ Win uses a tabbed dialog box to display or edit all of your settings,
while ECU+ Palm uses separate screens with a menu item for navigation.

To start the ECU+ Win configuration dialog, either click the hammer icon in the toolbar, or
use the Settings->ECU+ Head Unit menu item. To start the ECU+ Palm configuration, tap
the Palm menu button, then Setup and select the screen you'd like to work with.

Let's take a look at the configuration screens in turn:

9.1 The Fuel Maps

x
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Hllustration 51- The fuel maps tab lllustration 52- The fuel mapsseen

The fuel maps tab lets you configure the ECU+ head unit's fuel maps. The fuel maps tell the
ECU+ head unit how to modify the engine's mass air sensor (MAS) signal. To increase or
decrease the fuel flow to your engine, the ECU+ head unit modifies this MAS signal. The
MAS (in the car) produces a frequency proportional to the amount of air entering the engine.
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By modifying the MAS signal, the ECU+ head unit “lies” to the stock ECU about how much air
is entering the engine, which causes the stock ECU to change its fuel flow proportionally —
less air means less fuel.

The fuel maps contain 129 different “cells” - one for idle, and 32 cells for low, medium, and
high engine “loads,” as well as 32 cells for wide-open throttle conditions. Each cell
represents how the ECU+ head unit should modify the MAS frequency when the engine is
running at that particular load and RPM combination.

An example: let's say your car is accelerating at wide open throttle, and the engine is at 4000
RPM, and the cell value for 4000 RPM/WOT is -10%. If the engine's MAS frequency is 2200
Hz (representing some fixed amount of air flow), the ECU+ head unit will change this
frequency to 90% of 2200 Hz, or 1980 Hz, and pass this new frequency on to the stock ECU.
The stock ECU will then reduce the corresponding fuel flow by 10%, thus causing your car to
run approximately 10% leaner.

To set a given fuel map cell to a value, type in a number into the appropriate cell. On the
ECU+ Win software, you can select multiple cells with a mouse (left-click the first cell, and
Ctrl+left-click additional cells to select them), and use Alt+Up (arrow) or Alt+Down (arrow) to
easily increment or decrement a range of cells. Selecting a column header selects all of the
cells in that column. Similarly, selecting a row header selects all of the cells in that row. On
the ECU+ Palm software, use the minus ('-') key to help entering negative values (the Palm
Grafitti character set doesn't contain an easy way to enter this character).

Each fuel map cell can take on values from -50% to +50%, where negative numbers
decrease your engine's fuel flow (causing the engine to run leaner), and positive numbers
increase it (causing the engine to run richer).

Note that the ECU+ head unit interpolates values between the discrete levels in the fuel map
table. That is, if your fuel map cell value is -10% at 6000 RPM and -12% at 6250 RPM, and
your engine is running at 6125 RPM, the ECU+ head unit will adjust the fuel by -11%.

On the ECU+ Win software, a check box is available that tells the ECU+ Win software to
send fuel map changes to the ECU+ head unit immediately. If this isn't checked, values are
only sent over when you click “Ok.”

Within this tab on the ECU+ Win software, you can also load or save the maps as well as all
of the other configuration values (knock setup, analog outputs, and so on) from the ECU+
head to a file on disk. When saving, you're prompted for a filename only — both the fuel and
timing maps as well as the other configuration values are always saved. When loading, you'll
be presented with this dialog:
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Hllustration 53- Loading maps or configuration values

You can select to load just any combination of fuel maps, timing maps, or other configuration
values. By default, saved files have the .ema file extension, though you can also load the
values used in a previous capture by specifying the .ecd capture file here.

9.2 The Timing Maps

The timing maps tab lets you configure the ECU+ head unit's timing maps. The timing maps
tell the ECU+ head unit how to modify the engine's cam and crank angle sensor signals.
When the ECU+ head unit modifies the cam and crank angle sensor signals, it causes the
stock ECU to fire the spark plugs either sooner or later than stock, thus affecting the engine
timing.

The timing maps contain the same 129 cells that the fuel maps do, corresponding to a given
engine load and RPM, and are configured exactly like the fuel maps. The timing maps
specify a timing offset of between -15 and +15 degrees, where a positive value causes the
spark to fire earlier in the engine cycle, and a negative value causes a later spark. Thus,
positive values increase the engine's timing advance, and negative values decrease the
engine's timing advance.

9.3 Injector Scaling
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Injector scaling allows the ECU+ to compensate for larger or smaller injectors, while giving
you the full -50% to 50% adjustment range in the fuel maps. To use the injector scaling

feature, select a new injector size for either

the stock or current injectors. From then on, the

ECU+ will automatically scale the MAS output to compensate for the injector ratio defined

here.

Values between 420 cc and 780 cc can be entered here, and you can pick the values in from

the dropdown list (ECU+ Win only), or type

them in. Typical stock values are 450 cc on

manual-transmission DSMs, 420 cc on automatic-transmission DSMs, and 550 cc on EVOs.

9.4 MAS Tweaks
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As explained above, the ECU+ modifies the engine's mass air sensor (MAS) signal to make
changes to the fuel maps of the engine. This screen allows you to “tweak” the MAS settings
in various ways.

e Clamp Output Frequency Above - This sets the highest MAS output frequency that the
ECU+ will generate on its output. You can use this to limit the output MAS frequency to a
given value to avoid fuel cut on your vehicle. You can enter values between 1000 and
4000 Hz here. (The default is 3000 Hz.)

Some background: the stock DSM and EVO ECUs look at the frequency of the signal that
the MAS generates to determine when to begin “fuel cutting.” When the MAS frequency is
above a pre-programmed limit, fuel cut kicks in and the stock ECU turns off the engine's
injectors momentarily, thus causing the engine to stall. As soon as the MAS frequency
drops back below the pre-programmed limit, normal engine operation ensues.

By using the MAS frequency clamp, the ECU+ allows you to keep the MAS frequency
under the stock ECU's pre-programmed limit and thus avoid fuel cut.

To configure this value, make a series of full-throttle runs in which fuel cut occurs, and
save the captures. Make a note of the MAS output frequency of the ECU+ at the point
where fuel cut occurs. Then set the clamp to just below that fuel cut frequency.

Note: running your car with this upper clamp value activated is dangerous! When the
normal ECU+ MAS frequency is limited this way, your engine can easily run lean, which
can destroy your engine. This option is rarely used, since most high-horsepower engines
use large-enough injectors to make this option unnecessary, but if you need to use this
option, do-so only along with a air-fuel ratio meter to ensure your car never goes into a
dangerous lean condition.

® Decel Smoothing Factor — This is a value between 0 (off) and 10 that controls whether the
Page 60



ECU+ smooths its MAS output frequency during “decel.” A value of zero turns this feature
off, while higher values cause progressively greater smoothing to occur. A “decel” event is
when your car is decelerating, with your foot off of the gas pedal, and the clutch pressed
in. Under decel conditions, some cars with vent-to-atmosphere (VTA) compressor bypass
valve setups will stall because of lean conditions caused by dumping previously “counted”
air to atmosphere. By using decel smoothing, the ECU+ can compensate for this dumped
air and reduce or eliminate stalling on decel. If you have this stalling problem, try setting
this smoothing to a non-zero value and see if it helps. Values of 7-10 usually work best.

Idle Smoothing Factor and Clamp Output Frequency Below — These two (mutually-
exclusive) options are used to smooth out idle for cars with large injectors or aftermarket
cams. ldle smoothing reduces fluctuations in the MAS frequency at idle, which can reduce
or eliminate idle “hunting.” The Clamp Below function sets a lower limit on the MAS
frequency that the ECU+ will generate at idle, which can be used to set the ECU+'s MAS
output frequency to a fixed value at idle.

Tuning these two along with the idle fuel cell is a bit of an art. Here's the suggested
procedure:

- Set Idle Smoothing to zero, and the Clamp Below value to zero.

- With your car fully warmed up and idling normally, adjust the fuel map idle cell. You'l
want to monitor your front O2 voltages, and when you're withing a good range, your
front O2 voltage will cycle every few seconds between approximately zero and
approximately one volt. Try to set the idle fuel cell to the center of the range where the
front O2 is cycling. (For example, if the front O2 cycles when the idle fuel cell is
between -2 and 8, and doesn't cycle when outside of this range, set the idle fuel cell to 3
— the center of the range.)

- Next, turn on Idle Smoothing, and see if your idle improves. Higher values should
improve idle more.

- If your idle is still poor, turn off idle smoothing, and monitor the MAS output frequency
that the ECU+ is generating. You may find that this value varies quite a bit. Next, set
the Clamp Below value to a number that's a bit above the average of the MAS output
frequency seen above, and tweak this value until you achieve the best idle. You'll want
to verify that the front O2 sensor voltage cycles with your new Clamp Below value.
Typical Clamp Below values are in the 40-60 Hz range.
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9.5 Load Switching
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lllustration 58- The load switching tab

Illustration 59- e load switci creen

As shown on page 56, the ECU+ allows you to tune your engine via two 129-cell tables of fuel
and timing maps. The maps are indexed by a combination of engine RPM and “load.” There
are four load values defined: low, medium, high and WOT (idle is a special case of low load).
The WOT column is used when the throttle is fully depressed — Wide Open Throttle. The
low, medium and high load columns are used as a function of the input MAS frequency that
the ECU+ sees. This screen allows you to fine-tune what input MAS frequencies are used as
the switchover point between low-to-medium and medium-to-high loads. Enter new
frequencies here to fine-tune when the ECU+ switches between its load maps. If you're not
sure, use the default values of 500 Hz (low to medium) and 1000 Hz (medium to high).

9.6 Analog Outputs
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lllustration 60- The analog outputs tab

Hlustration 61- e anlog oups screen

The ECU+ has the ability to generate arbitrary analog voltages on four dedicated outputs.
This screen configures what analog voltages you'd like to see on the four outputs. For each
of the four outputs, enter a voltage between 0 and 5 volts here. This feature is primarily
designed for use with the ECU+'s MAS translation feature, but may be useful to generate

other signals as well.

9.7 MAS Translation
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lllustration 62- The MAS translation tab

lllustration 63- e MAS translto screen

The ECU+ includes the capability to work directly with a GM hotwire-style MAF (mass air
flow) sensor for better airflow. When used this way, the ECU+ will “translate” the sensor
frequency to be compatible with the stock ECU, while still giving you the full range of fuel

tuning available with the stock MAS.

On this screen, select the translation type you want the ECU+ to do.

Using the MAS translation feature requires special wiring and other configuration (beyond this
screen). See the section Using the ECU+ with a GM MAF Meter on page 75 for more

information.
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9.8 Knock
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lllustration 64- The knock tab lllustration 65- hknck screen B

The ECU+ is able to monitor the knock sensor signal on your car and read out a voltage
corresponding to how much the engine is “knocking.” Knock is very harmful to the motor, and
should be avoided at all costs. This screen allows you to configure various knock-related
parameters:

Knock Sensor Type — Select what type of knock sensor your car has. Only useful for the
DSM version of the ECU+.

Knock Display — When the ECU+ records and displays knock, it can show the
instantaneous knock “events” (knock will appear as a series of spikes on the knock view),
or a smoothed-out version of these, where the ECU+ grabs the most recent instantaneous
peak and holds it for a short period of time. This setting selects how you'd like to display
the knock signal.

Detonation Control — When the ECU+ sees a large knock signal, it can help you protect
your engine against detonation by automatically increasing fuel and retarding timing for a
second or two. The detonation control parameters configure this. Here, enter a knock
voltage above which the ECU+ will work its magic, and a percentage of fuel and a timing
retard. Fuel values can range from 0 to 25%, and timing values can range from 0 to 15
degrees. (Note that a positive timing value here retards timing — this is the opposite of how
the timing maps work, where a negative timing value retards timing.)

To use the detonation control feature, you should do some captures to determine what value
represents a “normal” knock voltage from your engine (you'll see residual knock voltages from
normal engine noise). Then set the knock voltage threshold about 0.20-0.50 volts higher
than this normal knock voltage.
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9.9 Miscellaneous Settings

ECU+ Head Unit Settings = x|
Fuel taps I Timing kaps I |njectar Scaling
M&S Tweaks | Load Switching | Analog Outputs
M5 Translation | Knock Miscellaneous

Input camm sensor type (Rl el R MRS

Hutput cam sensor tupe |199?’-1 935 DSk e j

Firmware werzion |2.EIEI
Sernal number |2DD15

Hobe: v'ou must power cycle the ECU+ head unit far cam sensor
changes to take effect.

[ebug
I Force MAS into bypass mode
[ Force camdcrank into bypass mode

QK I Cancel | Fiuu [t |

lllustration 66- The miscellaneous tab lllustration 67- miscellaneo creen

The miscellaneous settings tab lets you configure some random values in the ECU+ head
unit. These are:

® /nput Cam Sensor Type - This sets the type of cam sensor used on your car. Click the
dropdown button next to the type to set a new value.

e® Output Cam Sensor Type - This sets the type of cam sensor that the ECU+ head unit
should generate. As with the Input Cam Sensor type, click the dropdown arrow to set a
new value. Both the input and output cam sensor types should generally match your car -
this setting is intended for those people using a different cam sensor than stock on their
car. This is most useful for 2G DSM cars with a “6 bolt” motor configuration that has a 1G
cam sensor. For that setup, configure the input cam sensor for 1990-1994 DSMs, and the
output cam sensor to match your stock ECU.

® firmware Version — This displays the version of the firmware running in the ECU+ head
unit. Use this when submitting bug reports.

e Serial Number — This displays the serial number of your ECU+ head unit.

® force MAS Into Bypass Mode - This is a debugging option that forces the ECU+ to track
your MAS sensor signal with no changes. This effectively causes your car's MAS sensor
signal to pass transparently through the ECU+ head unit.

® force Cam/Crank Into Bypass Mode - Similar to the MAS Bypass option, this forces your
car's cam and crank sensor signals to pass transparently through the ECU+ head unit.
Note that neither the MAS Bypass nor the Cam/Crank Bypass check-boxes are
remembered by the ECU+ head unit - these are both switched off when the head unit is
powered down, and have to be re-enabled each time you start your car.
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10 On Board Diagnostics (OBD)

The ECU+ includes a complete OBD-II module that works with the stock ECU on 2G DSMs
and the EVO (support for the 1G DSMs will be available in a future software revision). OBD-II
is an SAE (Society of Automotive Engineers) standard that specifies that all cars
manufactured in 1996 or later must support a common port for diagnostic information.
Diagnostic information includes Diagnostic Trouble Codes (DTCs) which indicate the failure
of various vehicle systems, as well as real-time and freeze frame ECU data, like RPM and
throttle position. This diagnostic information is normally accessible only via expensive
dedicated “scan tools,” but the ECU+ now includes a full OBD-Il module that can access and
display the same information that these expensive scan tools can, and the ECU+ also
features real-time display of engine parameters and trouble codes.

You can use either the ECU+ Win or ECU+ Palm software to display the OBD-II information.
ECU+ Win uses a tabbed dialog box to display all of the information, while ECU+ Palm uses
separate screens with a menu item for navigation. The information presented is identical
whether you use ECU+ Win or ECU+ Palm, with the following exceptions:

The Palm software includes fewer trouble code strings. That is, you may see “Unknown
code” more often in the Palm software.

The freeze frame data is presented on a separate screen in the Palm software, whereas
it's integrated into the Stored Trouble Codes tab on the Windows software.

Some of the descriptive strings displayed on the Palm software are shorter and more
verbose.

(The above are generally due to the screen size and memory limitations of the Palm device.)

To start the ECU+ Win OBD-Il displays, use the OBD menu item. To start the ECU+ Palm
OBD-II displays, tap the Palm menu button, then tap OBD and select the screen you'd like to
see.

The available displays are as follows:

10.1 Information

This display is a real-time engine data monitor, and displays all of the information that the
stock ECU exports via OBD-II. This information is split into three sub-displays: Basic,
Advanced and Tests.

10.1.1 Basic
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%

Infomation | Stored Trouble Codes | Pending Troskle Codes |

Parannelar | Value |

Fud Spztem Status Clozed Loop [Mosma]
Syetem Load 2E

Coolant Temparsture 165 degF
Shaant Teem Fuel Tiim Bard: 1 -2%

Leewg Tesm Fuel Tnm Bank 1 4%

Inlake Manilold Presssue 42 kFa Absohute
Eruine Speed 571 APM
Vehicle Speed I MFH

Ergine Timing Advance 4 deg

Int=ke &r Temperabure TadegF

MAS A Flow by
Absoiute Thiolile Position 0

Diongen Sensot Vollage Bark 1 Senzor 1 09 walls
Dipgen Senzoe Voltage Bark 1 Senzor 2 01 valts

B Dmﬂ.\' ‘

[0k | cencal | geei |

lllustration 68 - The basic information tab lllustration 69 - The basic information screen

The basic information tab is a real-time display of various vehicle parameters as seen by the
stock ECU. Much of the information displayed here duplicates data that is available from the
ECU+, but it can still come in handy when debugging problems with your vehicle. An
example might be that your cruise control isn't working, and you suspect (or have a trouble
code to indicate) that your speed sensor is bad. By looking here, you may find that the stock
ECU doesn't ever see a vehicle speed over zero, and yet the ECU+ registers vehicle speed
just fine. That may indicate that the speed sensor wire is broken between the ECU+ tap point
and the stock ECU.

Other values displayed here are in addition to what the ECU+ can display or datalog. Some
of these are:

Fuel System Status — the stock ECU can run in one of two modes when controlling fuel to
the engine: open loop or closed loop. In open loop mode (used at WOT or high
acceleration conditions), the stock ECU looks up a fuel flow number in a table and turns on
the injectors for a fixed amount of time based on air flow, throttle position and the values of
the temperature and pressure sensors. In closed loop mode, the stock ECU hunts for a
perfect air-fuel ratio by monitoring the front O2 sensor and adjusting fuel flow dynamically.
When you see your front O2 sensor voltage cycling up (to around 1 volt) and down (to near
zero volts), that's the stock ECU hunting for a perfect (14.7:1) air-fuel ratio by alternately
running slightly rich (front O2 voltage around 1 volt) and then slightly lean (front O2 voltage
near zero volts). With this display, you can be sure what mode the stock ECU is using.
The display will show one of four values:

Open Loop (Normal) — either the front O2 sensor or the engine hasn't reached operating
temperature yet.
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Open Loop (Accel/Decel) — vehicle is accelerating or decelerating.

Closed Loop (Normal) — normal operation for low load driving.

Open/Closed Loop (System Fault) — a sensor problem has been detected.
System Load — this is a percentage of how hard the engine is running. 0-100%.

MAS Air Flow — MAS air flow is a computed number inside the stock ECU that takes into
account the MAS frequency (what you see on the ECU+'s display), intake air temperature
and barometric pressure. This number is displayed as a flow rate into the engine, in Ibs/hr.

Absolute Throttle Position — this is the same information as the ECU+'s throttle position
sensor voltage, except that it's displayed as a percentage rather than a voltage. The stock
ECU has fixed low and high limits for the voltage corresponding to “0%” and “100%” open
throttle, and displays an interpolated value here based on the true throttle position sensor
voltage.

Oxygen Sensor Voltage — bank 1, sensors 1 and 2 should correspond exactly to the front
and rear O2 sensor voltages as seen by the ECU+. The OBD-II specification allows a
vehicle to contain more than two O2 sensors, and so that specification categorizes the O2
sensors according to what engine bank and exhaust position the sensors are placed at.
The ECU+'s OBD-II module follows that naming convention rather than displaying the
values as front/rear O2 sensor voltages.

Short and Long Term Fuel Trims — these are the most important parameters displayed
here. As outlined above, the stock ECU can run in either open or closed loop mode. When
in closed loop mode, the stock ECU will adjust its fuel flow based upon feedback from the
front O2 sensor. The stock ECU contains a baseline set of fuel tables, pre-programmed at
the factory for the stock injectors. It uses these fuel tables as a starting point in calculating
the optimum fuel flow for a given air flow (and temperature/pressure readings) in closed
loop mode. From that starting point, the stock ECU will continuously (over a few seconds
worth of time) add, then subtract fuel in an effort to maintain a perfect (14.7:1) average air-
fuel ratio. But the stock ECU needs a mechanism to adapt for injectors that are out-of-
spec or clogged, and that is the short term fuel trim. You can think of the short term fuel
trim as an offset from the pre-programmed stock ECU fuel table values whose job it is to
compensate for imperfect injector flow rates.

With the ECU+, you're modifying the MAS air flow signal to influence fuel flow from the
stock ECU. At WOT (in open loop mode), where most tuning is done, the fuel trims don't
come into play. Under low and medium loads, though, the stock ECU uses these fuel trims
to maintain a perfect air-fuel ratio and thus give you good driveability and gas mileage. The
fuel trims have a limited range, and if your car isn't tuned properly under closed loop
conditions, the fuel trims will max-out in one direction or the other, thus causing your
engine to run consistently lean or rich in closed loop mode.

By monitoring the fuel trim display, you can see how well your engine is tuned in closed
loop mode. In general, you'll want to tune the ECU+'s fuel map for idle and low and
medium loads such that the fuel trims are near 0% when the car is operating in a given
range. If you find that the fuel trim is a negative value for a given range, then your engine
is running rich in that range and you should subtract fuel in that range of the ECU+'s fuel
maps. Conversely, a positive short term fuel trim number indicates that the engine is
running lean in that range, and you should add fuel with the ECU+'s fuel maps.

In general, you'll want to watch the short term fuel trim. The long term fuel trim is, as its
name implies, a longer-term average of the short term fuel trim. As with the short term
trim, this value should stay around 0%. By occasionally checking the long term fuel trim,
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you can be alert to changes in your injector performance that may require re-tuning your
car.

You may find fewer, or more, items displayed for your car than is shown in the screen shots.
As with all of the OBD-II screens, the ECU+ queries the stock ECU to see what values are
supported and displays only the supported data.

10.1.2 Advanced
X
Infomalion | Stored Trouble Codes | Bending Troukle Codes |
Parsmeies | alue |
tode 1 FIDz Supported 13456711,121304.
Mode 2 FiDs Suppoited 234567 01120304.
Mode & PiD: Supported 1.25
Mode B FIDs Suppoited 1.2345678911.14...,
Mode 2 iD= Supparted 291011.321214.15.18
Mumbes of Trouble Codes 3
MIL Ligt On
Freeze Frame Trouble Code PO300
Dipgen Sereor Locations Bank 1 Sensor 1, Bank. .
Diesign OBD Regumements OBD- [Cahifarrea ARB)
7 Pisplay————— ——
© Bask @ pdvanced O Tests
1] i Camcel Apply
lllustration 70 - The advanced information tab lllustration 71 - The advanced information screen

The advanced information tab is another real-time display which shows advanced OBD-II
information that may be useful for debugging software problems with the ECU+'s OBD-lI
implementation. Here's some of the things you'll see:

- Mode N PIDs Supported — this is a cryptic list of “PIDs” (parameter IDs) available in the
various OBD-Il modes that your stock ECU includes. Different OBD-Il modes perform
different functions, and the ECU+ needs to know what sub-functions are supported for
each mode. The ECU+ Win software displays this as a list of numbers. The ECU+ Palm
software displays this as a 32-bit hex number. The most interesting of these is the mode 1
PIDs, which specify which values will display on the basic information screens.

« Number of Trouble Codes - this is the number of Diagnostic Trouble Codes (DTCs)
currently stored in the stock ECU.

«  MIL Light — whether or not your MIL (malfunction indicator light, or check engine light) is on
due to a stored trouble code.

- Oxygen Sensor Locations — which oxygen sensor are supported in this vehicle.
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- Design OBD Requirements — which OBD specification this stock ECU supports. Potential
values include the early-model OBD, OBD-Il as well as the European and Japanese OBD
specs.

10.1.3 Tests
5

Ifoimalion | Stored Trouble Codes | Pending Treuble Codes |
Parsmeter | value |
Conbrwsous Test - Mizhre Supported/Complete
Contirwaous Test - Fus System Supported/Complels
Conbrwous Test - Components Suppoted/ Complate
Hon-Contiuous Tes - Catalst Suppoited/Comnplels
MonContrwous Test - Heated Catalpst Unzupported
Mon-Conbrwous Tes! - Evaporstive System Suppoited/Complele
MonContiuous Tesd - Secondam A Sestem Unzupported
Mon-Conbruwscus Test - A/ Rehigerant Unsuppoited
Mon-Contirwous Test - Dwpgen Seno Suppoited/Complete
Mon-Conbrwsous Test - Diopgen Sencoe Hea..  Suppoited/Complele
Hon-LContinuous Test - EGR Spstem Supported/incomplete

lllustration 72 - The tests information tab lllustration 73 - The tests information screen

The OBD-II specification requires manufacturers of vehicles to support various internal tests
for (generally) emissions-related functions. These tests determine whether the vehicle is
operating properly from an emissions point of view. The tests information tab displays the
results of these tests. You'll find two types of tests: continuous and non-continuous.
Continuous tests run continuously whenever the engine is running, while non-continuous
tests must be invoked manually with a scan tool. For each of the tests, the ECU+ will display
whether or not the test is supported by the stock ECU, and if the test is supported, whether it
has run to completion.

10.2 Stored Trouble Codes and Freeze Frame Data
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Information  Stared Trouble Codzs | Pending Trouble Codes |
Shored Codes

Cade | Explanation

PE240  Camchalt Posiion Sensar & Circuat
FOE35  Crankshall Position Senzor &' Ciicuil
FO00 Bandom/Muliiple Cyknder Mishre Detected

Freeze Frame Data
Paramelr | vahie |
Fued Spctem Statuz Open Loop BocelTec...
Spstem Load 14
Coclant Temperstue 179 degF
Skt Teem Fuel Trim Bark 1 0
Lorwg Tesm Fuel Tam Bank 1 14
Intake Manilold Presssue T kPa Absobute
Ergine Spead 275 RPM
Wehicle Speed 0 WPH
Engine Timing Advance Bdeg
Intake A Temperalure B4 degF
MAS Ak Flaw 0 bt
Abzolube Thioktle Position 14

_ Lew |
I._I]-E._._I Cancel | Apaly |

lllustration 74 - The stored codes and freeze frame lllustration 75 - The freeze frame data screen
information tab

Diagnostic Trouble Codes (DTCs) are how the stock ECU flags problems with your engine.
When a problem is detected by the stock ECU, it sets a trouble code and turns on the MIL
(malfunction, or check engine light) to indicate that a problem has occurred. Problems can
be simple, like no signal from a particular sensor, or complex, like “random misfire detected.”
These trouble codes can be displayed and cleared by the ECU+.

Two types of trouble codes exist inside the stock ECU: pending trouble codes and stored
trouble codes. Pending codes indicate that a problem was detected, but that the problem is
not (yet) considered to be important enough to turn on the check-engine light. Think of the
pending codes as an early-warning that something may be wrong. When a pending code
occurs frequently, or on multiple drive cycles, the pending code will be “promoted” and
become a stored trouble code. Pending codes that only occur infrequently are typically
forgotten after one or two additional drive cycles.

On the stored trouble codes tab, the ECU+ displays the stored trouble codes currently in
effect. All of the codes are displayed, along with the standard OBD-II trouble code
description. Additionally, a set of freeze frame data may also be displayed. Freeze frame
data is stored when an emissions-related code is stored. This freeze frame data is a
snapshot of what the engine was doing at the time the code was set, and is very useful in
tracking down the source of the problem. If multiple stored codes are present, the freeze
frame data applies (generally) to the first code that was seen, and the “freeze frame trouble
code” indicates which stored code is associated with the freeze frame data.
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| Infosmation Stored Troubie Codes | Pending Trouble Codes
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Code | E splanation:

PO340  Camzhalt Position Sensor &' Cicuat
PO335 Crankshaft Postion Sensor %' Cicuit
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x

I E Erase ALL trouble codes and freeze frams data?
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ECETT [l o l Cancel ] bee
Syestern Lo
Coolant Temperatuie 179 degF
Short Termn Fuel Teim Bank 1 0%
Loz Term Fuel Tom Bank 1 0%
Inlzke Manifold Presssue 7 kP Absolule
Ergine Speed 475 RPM
Wehicls Spesd 0 MPH
Ergine Timing Advance Sdeg
Intake &ir Temperature Bddeg F
MAS Ar Flow 0 bsir
Absolute Theoltle Postion 14

LClear

ok | cemest | oz |

Illustration 76 - The code-clearing confirmation prompt
On this tab, a button is provided that allows the trouble codes to be cleared. When invoked,

this will erase all stored and pending trouble codes as well as the freeze frame data. It will
also extinguish your MIL light.
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10.3 Pending Trouble Codes

E
Information | Stered Trouble Codes PudngTrn.HuEud::i

Bending Codes

Code | Explanation |
P00 RandomdMulipls Cobnder Mizhre Detected

ok || Cacsd | il |

lllustration 77- The pending codes tab

lllustration 78 - The pending codes screen

The pending trouble codes tab shows all of the codes that are currently pending, before they
are promoted to stored status. As with the stored trouble codes tab, a clear button is
provided to allow these codes to be cleared.

10.4 Using the ECU+ With Other Code Scanners

The OBD-II system supported by the ECU+ is normally accessed with a dedicated scan tool.
To use a scan tool, you connect the scan tool to the standard OBD-Il connector located under
the dash of the car, near the steering wheel. OBD-Il is a “single master, multiple slave”
system which only supports one master device, and as implemented, the ECU+ is the sole
master device. The ECU+ connects to the OBD-II port directly at the stock ECU's wiring
harness, and doesn't plug into the OBD-IlI under-dash connector at all. What this means is
that with the ECU+ connected to your stock ECU, you'll no longer be able to access the OBD-
Il functionality with an external scan tool. This can cause problems in two situations:

- If you take your car to the dealer or other repair facility, their scan tool won't work as long
as the ECU+ is installed.

- Some states are using the OBD-II port to initiate tests for emissions compliance. With the
ECU+ installed, these tests won't run and your vehicle will fail emissions testing.

There are two ways to handle these problems:

1. In the ECU+ wiring harness, locate pin 22 (black wire, group C) on the low current harness
and snip the wire in half. Then insert a quick-disconnect in this wire that will allow you to

Page 74



easily disconnect this wire whenever you need to access the OBD-II functionality with an
external scan tool.

2. Inside of the ECU+ head unit, there is an internal jumper that will serve this same purpose.
Remove four screws from each end of the ECU+ head unit, and slide out the printed circuit
board. Near the high current (white) connector is a jumper, JP8. Simply remove the
shorting block from this jumper and reassemble your head unit.

11 Using the ECU+ with a GM MAF Meter

The ECU+ has the ability to work directly with a 3” or 3.5” GM hotwire-style MAF meter in
place of the stock MAS on the DSMs or EVOs. This capability, which is similar to that
provided in the popular MAF Translator device, replaces the stock MAS with the lower-
restriction GM unit. The ECU+ will accept the GM MAF's output signal directly, and
“translate” it into a signal compatible with the stock ECU.

You can use the GM MAF in place of the stock MAS in the intake (between the air filter and
the turbo), or in a “blow through” configuration in which the stock MAS is removed and the
GM MAF is placed in the upper intercooler pipe between the compressor bypass valve and
the throttle body. The latter configuration has the side benefit of dealing well with compressor
bypass valves that are vented to atmosphere (VTA).

Below are the steps required to use this GM MAF setup:

1. Purchase the GM MAF of choice. Both the 3” and 3.5” MAFs are available from Mach V
Motorsports as well as other vendors for under $150.

2. Purchase a “pigtail” wiring adapter from Casper's Electronics, Inc
(http://www.casperselectronics.com). This item, part #108098, is called a “LT1 MAF
splice,” and it plugs into the GM MAF and breaks out the three electrical signals on the
MAF.

3. Plumb the GM MAF into your intake, in either the normal or blow through mode. Make
sure that the GM MAF is facing in the proper direction. The unit has an arrow on the body
that indicates the direction of air flow.

4. Make the electrical connections to the pigtail connected to the GM MAF, as follows:

lllustration 79- The LT1 MAF Splice “pigtail”

Pigtail black wire to ground.
Pigtail pink wire to a +12v source under-hood. Use a digital multimeter to verify the
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+12v signal before connecting it up.

Pigtail yellow wire to the ECU+'s MAS input wire (this is pin 4, orange, Group A on the
ECU+). To do this, extend the yellow wire through the firewall and into the passenger
compartment. Then, disconnect the ECU+'s pin 4 and connect it to the extended pigtail
yellow wire. This is the GM MAF's output, which you're connecting directly to the ECU+.

5. When you remove the stock MAS, you're also removing the stock air temperature and
barometric pressure sensors, which are built into the stock DSM or EVO MAS unit. You
need to make two more wiring changes that allow the ECU+ to output simulated air
temperature and barometric pressure sensor signals:

Barometric Pressure Sensor ToStock ECT
From 3ensor e Pin 16 (1G],
Pin85 2G/EVD)
Adr Temperature 3 ensor To&tock ECT
From Bensor I Fing (13,

Pin72 2G/EVO)

» To ECU+ Head Ut
Pin 33, Red, Group D

Standard Configuration

Barometric Pressure Sensor To Btock ECU
From Sensor ——e = Pin 16 (1G),
Pin35 2G/EVD)
From ECU+Head Uit
Pin 16, Green Grouwp B
Adr Temperature 3 ensor To8tock ECU
From Sensor — = e Pin3 (10),
Pin72 2G/EVO)
From ECU+Head Ut » To ECU+ Head Unmnit
P15, Yellow, Group B Pin 33, Red, Group D

MAS Translation Configuration

lllustration 80- The analog wiring changes for MAS translation

Cut the air temperature wire (formerly) between the stock MAS and the stock ECU. This
is pin 8 on the 1G DSM ECU or pin 72 on the 2G DSM and EVO ECUs. Solder the
ECU+'s analog output 0 (pin 15, yellow wire, Group B) to the stock ECU air temperature
input. If you've purchased a PnP ECU+, you can cut the pin 72 wire in the ECU+'s PnP
harness.

Optionally, connect the ECU+'s analog output 0 back into the ECU+'s air temperature
datalogging input (pin 33, red wire, group D) as shown in the above illustration. If you
cut the air temperature wire to the “left” (in the above illustration) of the tee in the air
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temperature wire, you get this connection for free. If you choose to not connect this
signal back to the ECU+'s air temperature datalogging input, the ECU+ will display
strange values for the air temperature, though this won't affect how your vehicle runs.

Repeat the first step for the barometric pressure sensor wire. Cut it at the stock ECU
(or in the PnP wiring harness) and connect this stock ECU input (pin 16 on the 1G DSM
ECU, or pin 85 on the 2G DSM and EVO ECUs) to the ECU+'s analog output 1 (pin 16,
green wire, Group B).

6. Double-check your connections. When you're confident that the connections are ok, turn
your ignition to the On position (don't start the car yet) and use the ECU+ Win or ECU+
Palm software to navigate to the MAS Translation setup screen. Select the type of
translation that you need, based on the type of GM MAF you've purchased, and your car
type. Save this setting.

7. Finally, using the ECU+ Win or ECU+ Palm software, navigate to the Analog Outputs
screen, and set analog output 0 to 2.37 volts and analog output 1 to 3.90 volts. Save this
setting.

Once all of the above are complete, start your car. The car should start and run normally,
just like it did before the installation of the GM MAF. At this point, the ECU+ is doing the MAS
translation continuously and fooling the stock ECU into thinking it still has a stock MAS
connected. If you look at a capture, you should see MAS input and output frequencies that
are very similar to that of the stock MAS for a given RPM and load combination.

With the GM MAF in place, you should drive your car for a while and verify that the car runs
normally. Before doing any WOT runs, though, it's recommended that you (slowly) go
through the steps of tuning your car again for optimal air-fuel ratio. The MAS translation in
the ECU+ should only require minor changes to your fuel maps from the values used before
installing the GM MAF, but it never hurts to re-verify your fuel map settings to account for any
non-linearities of the stock MAS that have been corrected through the use of the GM MAF. In
general, the GM MAF will flow more air before becoming non-linear and introduce much less
restriction in the intake than the stock MAS.

Note: when using the GM MAF, you may notice that the input and output MAS frequencies
never go to zero. This is because the GM MAF is especially sensitive, and outputs a low
frequency signal even when the engine is not running.

12 Tuning Your Engine With the ECU+

This section provides some general information on tuning your car with the ECU+. Before
starting, please read and heed the following warning:

YOU CAN DESTROY YOUR ENGINE WITH THE ECU+!

Neither the manufacturer nor the distributor of this device are responsible for any
damage done to your vehicle due to the use of this device.

Always remember the above when tuning your vehicle. If you're conservative when tuning,
you'll be able to use the ECU+ to make small, incremental improvements to your vehicle's
performance, and most important of all, not destroy your engine in the process. It's
sometimes said that engines make maximum horsepower just before they blow up...

To avoid destroying your engine, keep in mind that an excessively lean mixture and timing
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that is too-far advanced can lead to detonation. Excessive detonation will destroy your
engine's internals. So be very very careful when reducing fuel flow or advancing timing with
the ECU+ system.

12.1 “Tools” Required
When tuning your car, you should have the following “tools” available:

1. The ECU+ system (of course), with the ECU+ Win software running on an in-car laptop.
2. A boost gauge, and possibly the ECU+ map sensor, wired into the system.

3. An Exhaust Gas Temperature (EGT) gauge. This allows you to monitor your vehicle's
exhaust gas temperature. Rapidly increasing EGT values often indicate detonation, which
you can also monitor with the ECU+'s knock logging capability.

4. A wideband O2 sensor. These are moderately-priced, standalone boxes that can display
your vehicle's air-fuel ratio very accurately. If this isn't available, the front O2 sensor in
your vehicle will make a (poor) substitute.

5. A friend to ride in the car with you. Your friend will pilot the laptop while you pilot the car.
Note: please don't refer to your friend as a “tool” - he might not appreciate it. :)

12.2 Making Runs

The best way to tune with the ECU+ is to make a series of dyno runs. See the section Dyno
Analysis on page 53. You should select a flat, deserted road and make a series of runs, one
per capture file, while giving the car a consistent few minutes to cool down between runs.
Between each run, make a single change in the fuel, timing or other parameters. Then pull
off the road and use the dyno analysis capabilities of the software to compare the most
recent run to the previous run and see how the horsepower and torque curves compare. This
will tell you whether you're making adjustments in the right direction or not.

You should start out by striving for consistency. The same section of road. Going WOT at
exactly the same RPM and launch point on the road. The same dyno numbers and curves
when you don't change anything. Once you've got a consistent set of dyno plots, change the
fuel, or timing, and make some more runs. See if the car gained horsepower in a portion of
the graph, or if it lost horsepower. Continue iterating until you've got the best performance
from your engine.

12.3 General Tuning Techniques

e Before beginning tuning, setup the injector scaling values. These establish a baseline fuel
offset for the injectors in your car.

® You should start with the injector scaling configured appropriately for your stock vs current
injector sizes.

e With the injector scaling values in place, set all of the cells in the fuel and timing maps to
all zero.

e Tweak the idle fuel map cell (as well as the values in the MAS tweaks configuration
screen) for best idle. You'll probably find that the larger the current injector size, the harder
it is to achieve a smooth idle.

e On the road, make several runs with the fuel and timing maps set to zero. Try to launch
your car from a roll consistently so that the resultant dyno plots are almost identical.
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o Next, make changes to the fuel maps for WOT conditions and do some more runs. Power
is generally gained by reducing the fuel map values, thus making the engine run leaner.
From the factory, most cars run very rich at WOT, and the ECU+ allows you to
compensate for that. For each change you make, make no more than a 2% fuel map
change from the last run. Change one or two fuel map cells at a time. When you bring the
car to a stop, you'll want to look at the front O2 voltage at WOT, which should be in the
range of 0.90-0.92 volts. Also look at the timing view and see how it compares to the
previous run. If you find that the timing suddenly drops off at high RPMs, or that the knock
display shows “spikes,” there's a good chance that the stock ECU heard some knock from
the motor. This indicates that you're running too lean — fix that right away. Also, when
you're doing the runs, always watch your EGT gauge for rapidly rising temperature. Again,
this indicates an overly-lean condition. If you have a wideband O2 sensor hooked up to
the ECU+, use that for tuning. Try to get your air/fuel ratios (at WOT) in the 11:1 range on
pump gas, and 12:1 on race fuel.

® Once you've optimized the WOT fuel tables, transfer the same values to the high load fuel
table cells.

e With the fuel table optimized, try tweaking the timing tables at WOT. Make only 1-2
degree timing changes between runs. Generally, you'll want to advance the engine timing,
thus moving the spark time backwards so that it fires earlier before top-dead-center (TDC)
of the piston. This means putting positive numbers in the timing map cells. As with the
fuel tables, make small changes and see what happens while watching for knock, high
EGTs and timing retard.

13 Troubleshooting Software Problems

This section provides some tips for diagnosing and fixing common software-related problems.
13.1 ECU+ Win Problems

13.1.1 The Software Never Connects

When | click on the “New Capture” button, a “Connecting” box pops up that says
“Connecting to the ECU+ head unit...”, but a connection never happens.

To “connect,” the ECU+ Win software looks for a specific stream of data from the head unit.
Whenever the head unit is turned on, it transmits this stream of data. If the ECU+ Win
software never sees the stream of data, it'll never “connect.”

There are several things you'll want to check:

1. Is the ECU+ hooked up to the serial port? You'll use the straight-through DB-9 serial port
to connect to your laptop. Double-check the connections, ensuring that the serial cable is
secure and tightened down on both the ECU+ head unit and laptop end.

2. Are you connected to the serial port on your laptop. On a laptop, serial ports are male DB-
9 connectors.

3. Does Windows recognize your serial port, and is it ok? Bring up the Windows Device
Manager (usually under My Computer->Properties->Hardware->Device Manager). You
should have a “Ports” entry for your serial port, and if you display its properties, Windows
should say “this device is working properly.”
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. Make sure the ECU+ Win software is using the correct serial port.
. Make sure there are no hardware conflicts. Sometimes Windows will “detect” a serial

mouse when none exists. Manually disable these in the device manager.

. Does the Palm software work ok? If so, the head unit is fine.
. Your car's ignition must be in the on (not accessory) position to power up the ECU+ head

unit.

As a last resort, you can use the HyperTerminal application to check to see if the ECU+ head
unit data stream is getting into your laptop. Here's how:

1.
2.

Make sure your ignition is off.

Close down all applications. Start HyperTerminal, which is (on Windows XP) under Start-
>Programs->Accessories->Communications.

. The "New Connection" dialog comes up first, type in "ECU+ Comms Test" and then Ok.
. On the next screen, leave the “Area code” and “Phone number” fields blank, and set the

"Connect using" field to COM1 (or whatever serial port you're using) and then Ok. Next a
"COM1 Properties" dialog will come up. Set "Bits per second" 1019200, "Data bits" to 8,
"Parity" to None, "Stop bits" to 1, and "Flow control" to None. Then Ok.

. Select File->Properties, then on the Settings tab, set the “Emulation” to TTY.
. Turn the ignition to the on position. You should now see junk streaming onto your

HyperTerminal screen. At the bottom status line, it should say "Connected <time> TTY
19200 8-N-1". See lllustration 81 for an example.
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If the HyperTerminal test shows data coming into your laptop, then the ECU+ Win application
should work. Note that you must configure HyperTerminal before turning on your ignition in
order for HyperTerminal to work correctly.

13.1.2 Glitches

| sometimes get glitches on my capture files when using ECU+ Win, but there are no glitches
with the Palm software. What's up?

The ECU+ Win application is a fairly CPU-intensive piece of software. If your laptop is slow,
ECU+ Win may not be able to keep up with the incoming data stream. This causes “glitches”
to appear in the captures. There are several things you can do to improve this:

1. Close all other applications when doing a capture.
2. Don't resize or move windows while doing a capture.

3. Within ECU+ Win, try to keep the number of graph views to a minimum. Redrawing the
graphs takes the most CPU time of anything in the ECU+ Win application.

4. Minimize the fuel and timing maps, if visible. These also require significant CPU time to
redraw in real time.

5. Minimize the ECU+ Win application while doing a capture.

6. Run a minimum of other software when using the ECU+ Win application. Common CPU
hogs include applications that show up in your system tray (next to the clock, lower right
hand corner of the screen) and anti-virus software.

13.1.3 Can't Open Serial Port
When | start a capture, ECU+ Win says it can't open the serial port. What could be wrong?

There are several possible reasons for this error. First, is the ECU+ Win software setup for
the correct serial port? Step through the diagnosis in the section “The Software Never
Connects” first. Once you've established that you have the correct serial port configuration,
check to see if some other device is using the serial port. Often, the Palm desktop and
HotSync applications will take over the serial port. Disable these applications and see if the
problem goes away.

13.2 Setup Problems

13.2.1 Read Error or Open Read Error

When installing files, | get “failed (open read error)” or “failed (read error)” on a file, and the
install stops.

This generally occurs when your laptop can't read the CD-ROM shipped with the ECU+,
either due to a bad CD-ROM drive or a bad or incompatible disc. Contact your dealer for a
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replacement CD-ROM, or if you have a way to transfer files from the Internet to your laptop's
hard disk, just download the software from the ECU+ web site at:

http://www.ecuplus.com/download.htm

The latest version of the ECU+ software is always available here. There will be a download
link for a file called “ecuplus_software_yyyymmdd.zip” (yyyymmdd is the date of release).
Download this ZIP file and extract it to a directory on your laptop hard disk, and then run the
Setup.exe program from there.

13.2.1 Write Error or Open Write Error

When installing files, | get “failed (open write error)” or “failed (write error)” on a file, and the
install stops.

The open write error means that a file couldn't be created in the directory that you specified
for the ECU+ software. This could be because the directory is write-only, or (Windows NT,
2000 or XP) you don't have permissions to write to that directory. Try re-running the
Setup.exe program and specify a different directory, or perhaps switch to a user that has
administrative access to the computer.

The write error generally means your disk is full, since the Setup.exe program couldn't copy a
file completely. Check to see how much disk space is free on your laptop hard disk, and free
up some space before running the setup program again.

14 Support and Getting Help

Because the ECU+ system is a complex device, you may have problems with the software or
installation. You have several lines of support open to you:

e For hardware installation problems, contact the dealer that you purchased the ECU+
system from. They're best equipped to handle these type of problems.

e For software support, again your dealer is a good first place to start.

e For tuning help, your best bet is the forums at forums.ecuplus.com. The forums are a
great place to hang out and learn about how others are using their ECU+. The forums are
also used to announce new software or firmware updates, and you can request new
features or ask almost any type of question here. If you own an ECU+, you should
definitely monitor the forums for the latest ECU+ news and information.

e For any type of support, you also have the option of e-mailing the ECU+ developer — just
send an e-mail to support@ecuplus.com. E-mails will generally be answered within 24
hours.

e If your ECU+ was working fine, but “breaks,” contact your dealer for information about their
return and repair policies.
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